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1 About This Book

1.1 General

This book describes the WinBraille software. The book is intended for system administrators and end users.

As a prerequisite, you should understand the basics for the Braille language and the functionality of
embossers in general.

1.2 Version

Version:2005-02-02

1.3 How to Use This Book

To get an overview of WinBraille and all the other Index Braille products, read Product Overview.

To get an overview of the news in this release of WinBraille, read News in this release.

As a system administrator you should read Installation for how to install and set up WinBraille.

As an end user you should start by making yourself acquainted with how to emboss documents. This is
described under Embossing.  If you then want to modify the default settings and preferences, read Setting up
WinBraille. You can also get detailed help by reading and following the Tutorials.

1.4 News in This Release

WinBraille 4.x has the following new functions compared with WinBraille 3.x:

Graphics
A full featured image editor is included in WinBraille. The editor can read and convert images from: bmp,
jpg, png, sig, wmf, gif and tif formats.  You can also include images in your Word document and directly
convert the whole document, including the images, into Braille and Tactile images.
Graphics is supported
· for version 3 Embossers firmware 11.01 or higher 
· for Windows 2000 and Windows XP

Graphics is NOT supported 
· for version 2 embossers
· Version 3 Basic, Everest firmware below 10.31
· Version 3 4X4 PRO frimware up to 11.00

Hyphenation
Hyphenation of the document can be done in several ways, you choose which to use:
· Wrap words shorter than a given number
· Hyphenate according to a specific rule file.
· Always hyphenate to get the text right aligned.

Updated user interface
A number of updates to the user interface has been done providing new features and simplifying the usage of
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WinBraille.

Spool file
The default location for the spool file for the WinBraille driver has been moved to "...Document And
Settings\AllUsers\Application data\WinBraille\AddPrinter\Print". Your system
administrator can also choose which directory the spool file shall be placed in.

Extended macro functionality
It is now possible to record menu selections in WinBraille

For more details, please read the readme file.

1.5 Document Conventions

The following text conventions are used.

Documented functions Format Comments
Speech Feedback "echoed message"
Starting programs menu 1/ menu 2/ menu 3 etc.
Program name "Program Name"
Selected menu in program "menu item/menu item"
Buttons in Dialogs OK  , Cancel  etc.
Dialog questions "Do you want to continue?"

1.6 Terminology

Term Explanation
Embosser Printer that produces Braille texts as raised indents in paper
Braille translation files Files used by WinBraille that define the text to Braille translation. The

Braille translation files is for contracted or not contracted Braille

1.7 Name Conventions

The various software products and deliverables provided by Index Braille are listed below together with the
short names used in this document.

Full name Short name Description
WinBraille WinBraille Braille editor for Index embosser
Index Embosser Utility Embosser Utility Support and installation utility for Index Embossers
Index IbPrint IbPrint Print utility for simple text files
Index Speech Tool Index Speech Software to make local speech interface on Index

Embossers
Index Braille Printer Driver Index Printer Driver The Windows drivers for the Index Braille

Embossers
Index Braille CD Index CD CD containing all Index Braille software
Index Braille Embosser(s) Index Embosser(s) The embossers produced by Index Braille
Index Setup Index Setup Installs Custom Packages
Index Add printer Wizard Add Printer Wizard Installs Index printer drivers
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Index Translation File Translation File Formerly called Rule File. The file that contains the
description of the specific language translation.

1.8 Related Documents

Document Title Description
Index Catalogue The Index Braille Product Guide
Index Braille Embossers Manual The Manual describes how to unpack, install

setup, use and maintain Index Embossers.
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2 Product Overview

2.1 WinBraille Software

The Index Braille software is either distributed as part of  WinBraille or as part of the Embosser Utility:

2.1.1 Software Requirements

 WinBraille supports the following Windows Operating systems and Microsoft Office Packages.

Operation System Office 2000 Office XP Office 2003
Win 2000 X X X
Win XP, PRO
SP2, Service Pack 2

X X X

Win XP, Home
SP2, Service Pack 2

X X X

Restrictions
The Macro for Adobe Acrobat requires version 5.x or 6.x of Adobe Acrobat. Please note that the Macro
does not support Adobe Reader .

WinBraille 4 do not support serial communication.

The computer must allow installation of Kernel mode drivers. 

Screen resolutions
WinBraille requires the following screen resolutions:

· 1024 x 768 pixels
· 1280 x 1024 pixels

For other resolutions, WinBraille could give faulty page layout on screen.
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2.1.2 Functional Overview

Exclusively for Index Users
After installation of WinBraille the user can emboss documents from the majority of  Windows compatible
programs in the same easy way as printing to a laser printer. A blind user can access WinBraille with a
screen reader, Braille display or synthetic speech. WinBraille automatically set up the Index Embosser(s).

Emboss from Word and other document types
The Index Embosser prints your Word document according to your standard template for Braille. Select
"File/Emboss" to emboss the document. All Windows editors and programs (for example MS Excel, MS
Explorer, MS Outlook) can be used with WinBraille. If you use MS Word, Adobe Acrobat and WinBraille
itself  you can also change the settings for the translations and embossing. 

Braille Translation
Translate contracted and uncontracted Braille using WinBraille. The definitions that are required to do the
translation for most of the major languages is available as custom packages. The number of languages is
steadily increasing, 32 and counting. With WinBraille you or your Index distributor can create a custom
package for your own language.

Graphics
Use WinBraille to insert and translate graphical images to tactile images with 0,5-2,5 mm resolution or build
tactile images directly with WinBraille's powerful Image Editor. WinBraille's graphical features give new
heights to the production of Braille books and Magazines. The Image Editor makes it possible for you to:
· translate images to Tactile Graphics
· adjust contrast, color etc
· import images files (BMP, TIF,  WMF, PNG, JPG, GIF, JPEG, SIG)
· insert Braille in tactile images
· insert tactile letters in tactile images

Note: Place one empty line before and after the picture to get better Braille tactile output.

Advanced Formatting
WinBraille contains functions for the automatic production of Braille books and newspapers: dual page
numbering (ink/braille), headers, translation into several languages in the same document, tables, bullets,
header/footer handling and advanced formatting.

6-dot key entry
WinBraille supports 6-dot key entry.

Support of Index Version 2 Embossers
WinBraille supports older Index Embossers.

2.1.3 Index Printer Drivers

The Index Printer drivers take care of the integration between the Windows operating system and the Index
Embossers. Install them using the Add-Printer Wizard (started from WinBraille).

2.1.4 IbPrint

IbPrint is a straight forward drag and drop program for printing text files, setup files, vertical alignment files
etc to Index Embossers. See Embossing using IbPrint for details.
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2.2 Other Index Braille Software

Firmware
The Index Firmware is the software that executes in the Embossers. It is stored in the embossers EEPROM,
see the Index Braille Embossers manual for details.

Embosser Utility
You use the Embosser utility  mainly for:
· Firmware upgrade
· Local speech upgrade
· Installation of  Own Braille tables
· Network setup

See the Index Braille Embossers manual for details

Index Speech Tool
Index Braille distributors use the Index Speech Tool to create local speech for the embossers user interfaces.
It is therefore password protected. If you are an Index Braille distributor contact Index Braille support for
password and help. As an Index Braille distributor you create the speech recordings using the tool and send
them to Index support. Index Braille takes the resulting speech files, converts them to embosser format and
places them at www.indexbraille.com.

2.3 Other Index Braille Products

Embossers
Index Embossers have been delivered in centuries to the blind community and to the people that serve the
blind. See the Index Braille Embossers Manual.

Acoustic Cabinets and Hoods
Embossing is by the very nature of the task, fairly noisy. Index Braille provides acoustic cabinets that makes
it possible to place the embossers in an ordinary office environment. See the Index Braille Embossers
Manual.

Braille Stapler
Index Braille also provides a Stapler, dedicated for Braille documents and books, see the Index Braille
Embossers Manual.

2.4 Support

WinBraille together with all other  Index Braille software is available on the Index CD, included in all
Embosser shipments. WinBraille and WinBraille upgrades are also available over internet, 
www.indexbraille.com, free of charge.

http://www.myhomepage.com/index.html
http://www.myhomepage.com/index.html
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3 Installation and Start Up

3.1 Installation Phases

The installation is divided in four phases;
· Answer questions about destination folder, license agreement etc.
· Custom installation of WinBraille (Profiles, Translation Files etc.)
· Adding printer drivers to the system.
· Test page print out.

Verify that you fulfill the Software Requirements before you start the installation of WinBraille.

3.2 Preparing the Installation

If any of the following statements are true, read the corresponding section, otherwise go directly to 
installation overview.
·   You have a previous WinBraille 2.0 installation on your computer, go to Upgrading from WinBraille 2.0

.
·   You want to add a TCP/IP port in Windows 2000 Server, go to Adding a TCP/IP port in Windows 2000

Server. 

Update to latest WinBraille version
Your computer has to be connected to Internet or have the latest Index CD installed
Close all other programs
Select Internet, Check for Upgrades..., and upgrade your WinBraille

3.2.1 Upgrading from WinBraille 2.0

If a previous installation of WinBraille 2.0x has been installed in the system (WinBraille 2.04 or lower) this
installation must be removed from the system before installing WinBraille 4.00. To be sure the drivers are
removed from the system in Windows 2000, a check could be done in the Printer folder
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 Select "Server properties/Drivers" and remove
all WinBraille drivers.

3.2.2 Adding a TCP/IP port in W2000/Server

To connect the embosser to the Ethernet port, a valid TCP/IP port must exist in the system before running
the Index Add Printer Wizard.

Select Server Properties in the printer folder and
switch to the Port tab.
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Press Add Port
Select "Standard TCP/IP Port" and press New
Port…

When the Add Standard TCP/IP Printer Port Wizard
starts up, press the Next button to continue.

  
Ask your Network administrator for a valid IP address. If the network is DHCP configured it is possible to
associate the MAC address in the embosser to a fixed IP address. To get the MAC address for the Embosser,
press HELP + HELP on the front panel and the Embosser will emboss a page with the settings of the
embosser. The MAC address is included in the Braille page. Another solution is to create an IP address
outside the DHCP IP-range.

After entering a valid IP address, press
the Next button.

The port will now be available from the
Index Add Printer Wizard.
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3.3 WinBraille Installation Overview

Installing WinBraille
Install WinBraille from the Index CD from or www.indexbraille.com. Start the program and follow the
installation wizard instructions. If a security messages pops up, press Run to continue. 

Note: To install WinBraille you have to be logged in as system administrator.

Step Name Action Comments
1 Welcome Next Information about WinBraille Version.
2 Licence

agreement
Check Accept agreement, press 
Next

Information, General Licence agreement for all
Index Braille softwares

3 Compatibility Next Information, Supported Windows Operation
System and Office versions

4 Select
Destination
Location

Normally: Check accept default,
press Next

5 Select
Components

WinBraille Installation (Normal)
Printer Driver Installation 

WinBraille installation = Normal installation of
WinBraille including Index printer drivers.
Printer driver installation = Index Printer Driver
installation when used with other Braille editors

6 Select Start
Menu Folder

Normally: Check accept default,
press Next

C:/..../Index Braille/WinBraille

7 Select Additional
Tasks

Normally: Check accept
default,"Create desktop icon",
press Next

Desktop icon = at your desktop
Quick Launch icon = at task bar

9 Ready to Install Software location information;
press Install

Information summary of the selected
information, start the program installation. 

10 Install
Application
Components

Select MS Office and/or Adobe
Acrobat and press Start
Installation

Installs Macros for MS Office and Adobe
Acrobat 5.0 or 6.0. 

11 Index Custom
installation

Select "Index Default Installation"
if your language is not available
from the list and then press Next

Local automatic set ups of:
WinBraille profiles, Braille translation
languages, templates, paper size etc

12 Index Custom
Installation
Option

Select Embosser Model; Press 
Finish to start "Add Printer
Wizard" for selected embosser.

1 = Index Printer Driver not installed: Complete
the Add Printer Wizard
2 = Index Printer Driver already installed:
Select "no" in the confirmation message.

Required information:
 - Embosser model and version
 - Communication: USB, Parallel, Network,
Serial
Network: TCP/IP address

http://www.myhomepage.com/index.html


11Installation and Start Up

Index Braille AB

13 Emboss a test
page

Check Accept to emboss test page See Emboss a test Page

14 First time:
Opens the
Readme
document

Press OK The document presents the WinBraille revision
history. When you press OK WinBraille reads,
translates and embosses

3.3.1 Macro Install and Uninstall

Use WinBraille in Professional edition. Change it to Professional edition by "View/ professional edition".

Install Macro
Close all Microsoft Office and Adobe Acrobat programs. 
From WinBraille select "Tools/ Application Components/"
Press Install... 
Check Microsoft Office and/ or Acrobat and press Install

Uninstall Macros
Close all Microsoft Office and Adobe Acrobat programs. 
Select "Tools/ Application Components/"
Press Uninstall... 
Check Microsoft Office and/ or Acrobat and press Uninstall Components

3.4 Installation Details

The WinBraille system consist of two parts, the application WinBraille and the necessary printer drivers for
communicating with the Embossers. Select "WinBraille Installation" to automatically install both the 
WinBraille and the necessary printer drivers for the Embosser.  The "Printer driver Installation" selection
will only install printer drivers. 

If you are installing an Index Embosser on a Windows Server you should choose the "Printer driver
Installation" because the WinBraille application is not needed on the server.

WinBraille can be installed from the Index CD or downloaded from www.indexbraille.com.

http://www.myhomepage.com/index.html
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3.4.1 Downloading WinBraille

Download WinBraille from the Index Braille web page: http://www.indexbraille.com/downloads/

Select a proper language and Download
Choose a language for the WinBraille menus and press the Download button. Save the file (Approximately
15 MB) on your hard drive.

3.4.2 Starting WinBraille

After a  WinBraille installation you can
start WinBraille either from your desktop
icon

or by selecting WinBraille using
"start/Index
Braille/WinBraille/WinBraille"

3.4.3 Installing WinBraille

Installing WinBraille
Login with Administrator rights
Close all programs on your PC
Start the WinBraille installation Wizard, see WinBraille Installation Overview

http://www.indexbraille.com/downloads/
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Installing a Custom Installation Package
The Custom Installation Package will install all default settings for selected language or distributor. See 
Custom Installation Package. 

Installing an embosser 
If you answered Yes above the Add printer Wizard is automatically started. See Add printer Wizard
instructions for further information.

3.4.4 Embossing a Test Page

You are asked to send a test page to the embosser when you start WinBraille for the first time. Make sure
that you:
· have connected the embosser to the computer,
· the embosser is turned on,
· you have selected the correct embosser from the list if you have more than one embosser

before you press the OK button. 

A test page with a predefined pattern will be sent to the embosser. See the figures below. If you have a
single sided embosser they will come in two sequential pages and on a double sided embosser the left figure
is the front page and right figure the back page.

3.4.5 The Readme File

WinBraille opens a Read me document when you start the program for the first time. This document
contains some information on how to use WinBraille, and changes since the last version. Please read the
document before you start using WinBraille. 

Note: This document is only shown the first time you start WinBraille.
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4 Setting up WinBraille

4.1 Select Standard or Professional Edition

Standard Edition
In the Standard Edition, all
settings are applied for the
whole document. WinBraille is
by default set to standard edition
after installation. 

Professional Edition
In Professional Edition the Braille Formatting template is visible. You can create and manage Braille
formatting templates independent of the profiles.
To switch between the Standard and Professional, select the "View/ Professional Edition" menu item. 

Enabled Functions in Professional
WinBraille Menu Tool Edit Rule File...

Index Add Printer Wizard...
Index Setup...
Language...
Macro ->
Application Components ->

Document Options Document Properties...
Braille Format...
Braille Style Format...
Change Profile...
Shortcut ->
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Information connected to
a specific Style 

Paragraph Setting of how to handle spaces, tab,
indents, line spacing, alignment

Translate Select Braille translation language
and exception file

Separator Select separator line, position,
character and justification

Hyphenation Select on/off, methods

4.2 Setup Overview

Standard Edition

Menu
Profile/Shortcuts->

Used for For more information see Comments

· Preferences... Automation level, Braille or
character, zoom, display

Setting up Preferences

· Embossers... Embosser model, Old
firmware, Single or double
sided, z-folding

Setting up Embossers Frequently used

· Page layout... Braille page size, margins Setting up Page Layout Frequently used

· Headers... Braille page number etc Setting up Header Frequently used

· Graphics... Graphic function on/off Setting up Graphics Frequently used

· Tables... Tables from Excel, Word,
three alternative formats

Setting up Tables

· Lists... Bullet and numbering lists Setting up Lists

· Source Page
Number...

Separation line with source
page # in Braille document

Setting up Source Page
Number

· Reformatting... Space, empty line, new page
convert ion to braille doc

Setting up Reformatting

· Hyphenation... Hyphenation, three
alternatives

Setting up Hyphenation Frequently used

· Translate... Language - select text to
Braille translation
(G0=Computer, G1=Literary,
G2=Contracted)

Setting up Translate Frequently used

Professional Edition
Menu Profile Used for For more information

see
Comments

PROFILE

· Preferences... Automation level, Braille or
character, zoom, display

Setting up Preferences Global

· Embossers... Embosser model, Old
firmware, Single or double
sided, z-folding

Setting up Embossers Global

· Page layout... Braille page size, margins Setting up Page Layout Global

· Headers... Braille page number etc Setting up Header Global

· Graphics... Graphic function on/off Setting up Graphics Global

· Formatting
Template

-> Select template and Edit
formatting template 

TEMPLATE
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· Tables... Tables from Excel, Word,
tree alternative formats

Setting up Tables Template

· Lists... Bullet and numbering lists Setting up Lists Template

· Source Page
Number...

Separation line with source
page # in Braille document

Setting up Source Page
Number

Template

· Reformatting... Space, empty line, new page
conversion to Braille
document

Setting up Reformatting Template

· Styles -> Select Braille style and
modify Braille style

See Styles Default = All styles inherit
style template values from
_DEFAULT

BRAILLE STYLE

· Inheritance The information in selected
Braille style is:
· Own setting
· Inherit from Braille Style

(_DEFAULT)

See Inheritance Default = the information in
all Braille Styles inherit
from _DEFAULT

· Paragraph Setting up Paragraph Braille Style

· Translate Language - select text for
Braille translation
(G0=Computer,
G1=Literary,
G2=Contracted)

Setting up Translate Braille Style

· Hyphenation Hyphenation, three
alternatives

Setting up Hyphenation Braille Style

· Separator Separation line before or
after a paragraph

Braille Style

4.3 Setup a Personal Profile

Use the personal profile to setup WinBraille for a specific working task, for example to emboss email on an
Everest with A4 paper. For detailed information see Tutorials Create a Personal Profile

4.4 Frequently used settings

4.4.1 Setting up the embosser(s)

The first you should do is to set up the embosser(s). Click  "Profiles->Embosser":
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Choose embosser and then set up the embosser settings or verify that the defaults are to your satisfaction, see
the table below.

For more information, see Embosser.

4.4.2 Setting up the Page Layout

Next you should set up the paper margins, the page size and orientation. Click  "Profiles->Page layout"
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Set up the paper or verify that the defaults are to your satisfaction, see the table below.

For more information, see Page Layout.

4.4.3 Setting up the Header

To set up the header, Click "Profiles-> Header":
  

 
 
Set up the header, the defaults are shown below.

For more details, see Header.
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4.4.4 Setting up Graphics

To set up the tactile Graphics, another important setting,  click "Profiles-> Graphic":

See Graphic for more information.

4.4.5 Setting up Hyphenation

See Hyphenation for more information.

4.4.6 Setting up the Braille Translation

To set up the text to Braille translation,  Click "Profiles-> Shortcuts -> Translate" (WinBraille Standard
Edition)
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It is vital that you choose the correct translation file and exception file for you document(s). The defaults
below are normally only relevant if you use american English.

See Translate for more information.
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4.4.6.1 Capital Prefix on/off

Select "Translation" and press "Properties". Select capital prefix on or off, this option is normally available
in literary braille translation files (rule files).

4.5 Advanced Settings

4.5.1 Saving your work in a Project

In WinBraille you will work with both the source
and the translated document. Save the complete
work as a project (WIF-file) using 
"File/Save As Project" 

A project file is used to move WinBraille files
from one computer to another computer even
when the embosser model or paper size differs.
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4.5.2 Setting up Preferences

Click Profile->Preferences to open the following dialog:

The table below describes the settings you can make and the defaults:

For more information, see Document Properties.

4.5.3 Using Templates

The Templates include formatting and Braille translation information.

Standard Edition
(Professional edition not
checked)

Professional Edition
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Formatting Information:
Tables
Lists
Reformatting

Complete document Complete document

Braille Translation settings
Translate, Braille translation file
(rule file)

Complete document Connected to each Style

Other Style Template Settings:
Tables 
Lists (bullet list)
Source Page Number

Complete document Complete document

Other Style Template Settings:
Reformatting
Hyphenation
Separation

Complete document Connected to each Style

See Setup Overview

Default Style 
The style _DEFAULT exists in all Templates. This style is created automatically when you create a new
WinBraille Template. If you use a style that is not available in the currently selected template, that style will
inherit its features from the _DEFAULT style. 

Creating a new template
Delete the text in the WinBraille source Window, the Style information is still included in the "empty"
document. 
Save the new Template; File/ Save as Template/ File name (example EnFrTemplate.wtf)
See Create a Personal Profile for more examples how to create and use templates.

4.5.4 Creating a Custom Installation Package

A Custom Installation Package is a package of profiles, templates, menu languages and Braille translation
files used for a specific market. See also  Index Default Installation for the defaults used at installation.
See "Index Setup" instructions.

4.5.5 Using the Automation Modes

Edit Source Document
Set "Automation" to "Edit source document" to make WinBraille the main Braille word processor.
WinBraille will then show the original "Source document". Translate to Braille according to the default
profile, by pressing CTRL+T. WinBraille will translate, format and display it. 
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Edit Translated Document
The document will be translated to Braille before WinBraille displays it. Both the source and the translated
document is displayed, see the figure above.

Complete Automation
When you use "Complete automation", WinBraille will work in the background. It is not possibly to include
tactile graphics in this mode.

4.6 Distributed Installation

Only for Networks Administrators.
This function makes an exact copy of the WinBraille installation on several clients. 

1. Download the latest WinBraille version, for example wbeng41x.exe.
2. Run the installation program with the parameter /SAVEINF:

wbeng41x.exe /SAVEINF=file.inf
3. Copy wbeng41x.exe and file.inf to the other machines or to a CD.
4. Go to the machines and install (from the CD) with the command:

wbeng41x.exe /LOADINF=file.inf /SILENT
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5 Embossing

5.1 Embossing from Word

The WinBraille installation installs an Emboss button just below the tool bar in Word.

Press Emboss to emboss your document on an Index Braille embosser. The document will be formatted and
translated according to the settings in the default profile in WinBraille

5.2 Embossing from Excel

The WinBraille installation installs an Emboss button just below the tool bar in Excel.

Press Emboss to emboss your document on an Index Braille embosser. The document will be formatted and
translated according to the settings in the default profile in WinBraille
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5.3 Embossing from Windows

The tutorial uses Notepad to demonstrate how to emboss from a Windows application.
Select the "File"->"Print" menu.

2910x1648 pixels (displayed at 1456x825)2910x1648 pixels (displayed at 1456x825)

The standard Print dialog appears. Select the "WinBraille" printer (embosser).

4384x3685 pixels (displayed at 2194x1844)4384x3685 pixels (displayed at 2194x1844)

Press Print to emboss the document. The document will be sent to the selected embosser "WinBraille" with
the WinBraille default Profile. 

5.4 Embossing using IbPrint

To emboss ordinary text files to Index
Braille Embosser you can use the
utility IbPrint. The application can be
found in the WinBraille directory.
Create a shortcut to the program and
place it on the desktop if you need to
emboss text files directly.
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To emboss a file using IbPrint just
drag and drop the file on the
application. Select the Embosser and
press Print.

 IbPrint do not support tactile graphic on 4X4 PRO.

5.5 Embossing using Duxbury Files

Open and emboss the translated Braille file (*.brf) from for example Duxbury.
Open with the command "File"->"Open" menu and select file type (*.brf).
Press Emboss to emboss your document on an Index Braille embosser.
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6 Tutorials

6.1 Embossing Braille with Tactile Graphics

Insert a clip art picture into a Word document

Emboss to WinBraille
Start with WinBraille in "Professional edition".
Select "File"->"WinBraille"->"Emboss" when you are ready to emboss the document. Use the menu, not the "Emboss"
button. 

7956x3411 pixels (displayed at 3975x1706)7956x3411 pixels (displayed at 3975x1706)

Setup the Profile to include graphic by Profile/ Shortcuts ->/ Graphics/ 
Select the "Graphics" category and check the item "Include graphics in translated document"
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Select the Automation option "Edit source document"

5348x3163 pixels (displayed at 2675x1581)5348x3163 pixels (displayed at 2675x1581)

WinBraille starts and shows the source document. 
Select "Braille"->"Translate" from the menu.
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6416x2790 pixels (displayed at 3206x1394)6416x2790 pixels (displayed at 3206x1394)

WinBraille formats and translates the document. The image will also be transferred to the translated
document, but not converted. Double-click on the image. A message box pops up, select to edit the image.

6416x2790 pixels (displayed at 3206x1394)6416x2790 pixels (displayed at 3206x1394)

Press Edit Image. WinBraille Image Editor starts and displays the image.

2882x1586 pixels (displayed at 1444x794)2882x1586 pixels (displayed at 1444x794)

Start by setting the proper size before image conversion. Select "Resize"->"Color Image".
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Select the following in the Resize Image dialog. 
· Keep the resolution as it is. 
· Check the "Resample" option. 
· Check the "Keep aspect ratio" option. 
· Set the width to 140 mm. 
· Press OK.

3137x2241 pixels (displayed at 1569x1119)3137x2241 pixels (displayed at 1569x1119)

Select "View"->"Zoom", and select zoomfactor.

Convert the color image to a tactile image: Select "Convert"->"To Tactile Image"
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Press OK. The next dialog lets you change the convertion parameters. 

3137x3198 pixels (displayed at 1569x1600)3137x3198 pixels (displayed at 1569x1600)

Here is the result:

4422x4048 pixels (displayed at 2213x2025)4422x4048 pixels (displayed at 2213x2025)

Let us enter Braille text. Select the Braille tool, either from the tool bar (the button ) or from the menu
"Tools"->"Braille".

4422x664 pixels (displayed at 2213x331)4422x664 pixels (displayed at 2213x331)
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Type the text "Eiffel tower"

4876x1905 pixels (displayed at 2438x950)4876x1905 pixels (displayed at 2438x950)

Hoover the mouse cursor over the image and press the left button. The Braille text appears surrounded by a
red frame. Place the text at a proper location and release the button. You can replace the text as long as the
Braille dialog is opened and the red frame is visible.

4422x4048 pixels (displayed at 2213x2025)4422x4048 pixels (displayed at 2213x2025)

The red frame disappears and locks the text when you close the Braille dialog.



34 WinBraille 4 User's Manual

Index Braille AB

4422x4022 pixels (displayed at 2213x2013)4422x4022 pixels (displayed at 2213x2013)

Select "File"->"Exit" to exit WinBraille Image Editor and return to WinBraille with the converted tactile
image included.
Note: Place one empty line before and after the picture to get betterBraille tactile output.

6283x4004 pixels (displayed at 3144x2000)6283x4004 pixels (displayed at 3144x2000)

Emboss the document on your Index Braille version III embosser, firmware 10.31 or higher.
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6.2 Embossing Multiple Braille Languages

Start with WinBraille in "Professional edition".

The tutorial shows how to translate several languages in the same text, in this case combining English grade
2 with French grade.

Make a French Style in Word

1. Make a document with the required styles. Example type the words "Normal" and "French".
2. Type a new style name (French) in the style Window in Word, press enter.
3. Select a Paragraph in your document and the style (French)
4. Select another Paragraph in your document and select "Normal"

Emboss the Word Document to WinBraille
Go to "File/ WinBraille/ Emboss"



36 WinBraille 4 User's Manual

Index Braille AB

Create a Template
Delete the text in the WinBraille source Window, the Style information is still included in the "empty"
document. 
Save the new template using  "File/ Save as Template/".

Create an English French Profile

From "Profile/ manage profile/ " select
the default profile and press Copy. 

Enter "English French Profile" as the
name of the new profile.

Uncheck "Create Template
Automatically" to expand the window,
see the next figure.
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Check "Select template" and select  the
previously created template
"EnFrTemplate".

Press OK.

Connect the French Braille Translation to the Template

Use "Profile/
Manage
Template... /" then
select the template
from above
"EnFrTemplate"
and press Edit.

Press "Inheritance"
and check  "Use
own settings for this
style"

Press Translate and
select a Rule File
(Braille translation
language and grade)
in this case
French_g1.ibk and
press Update
Template
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During the Update
Template process
this message will be
displayed. You have
the following
choices:
Select "Change only
current style" (The 
Style with
translation following
French_g1.ibk)

Emboss a Multiple Language Document

1. Make a document in Word with two Paragraphs
2. Select first Paragraph and the "Normal" Style
3. Select second Paragraph and the "French" Style
4. Emboss to WinBraille

"File/ WinBraille/ Emboss" and select "English French Profile"
- Press ctrl T  to translate to Braille 
- then emboss using "File/ Emboss"

5. Resulting Braille printout
First paragraph = English grade 2 Braille
Second paragraph = French Grade 1

6.3 Creating a Personal Profile

This profile is made for Braille book production on a Basic-D using 11" paper.

The Tutorial describes how to make a personal Profile with the following characteristics.
1. Paper length 11 Inch
2. Page Numbering, Odd pages, right upper corner, Even Pages Left upper corner
3. Formatting of  "Header 1" with centred justification and separation line above
4. Formatting of all other text as _Default
5. Braille Translation Language american_grade2.ibk
6. Hyphenation, in all text except "Header 1"

Set WinBraille in
Professional mode.

Select "Profile/ Manage
Profile..."
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Press Create New, give the
Personal Profile the name 
"11 Inch, Book" and select
the Basic-D embosser from
the list. 

Set Page Length to 11 Inch.
Select Page Layout (this
Window will automatically
be displayed), select your
paper size and enter margin
values.

Select Heading and type
"%b" for Braille page
number.
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Select
"Form
atting
Templ
ate"
and
press 
Edit
Form
atting
Temp
late

Select
"Style,
_DEF
AULT
" and
press 
Modif
y
Braill
e
Style.
Check
"User
own
setting
s for
this
style"

Select 
"Trans
late"
and
select
americ
an_g2.
ibk
from
the list
Select,
Hyphe
nation
,
check
"Wrap
lines
with
less
than
3".



41Tutorials

Index Braille AB

Press 
Updat
e
Profil
e and
check
"Chan
ge the
Defaul
t
Profil
e".

6.4 Using Profiles

Typically you use profiles to define the settings for a specific Index embosser. The most frequently used

settings are alternative paper sizes and Braille translation languages (rule files). 

Here follows an example how to setup and use a profile.

Install Everest and Basic Embossers
Start by installing two embossers using Add Printer Wizard (or use two already installed embossers).
Install Everest as a Network Printer in Add Printer Wizard.
Install Basic-D as a USB Printer in Add Printer Wizard.

Create Two Profiles per Embosser
Follow the example Create a Personal Profile to create the following profiles:
· Basic D 11 inch, USB
· Basic D 12 inch, USB
· Everest, A4, Network
· Everest, Letter, Network

Edit the Personal Profiles
Setup your personal Profile values to the specific embosser. Adjust the paper length. 

Adjust paper length on Basic-D to 11 inch in the Profile Basic-D, 11 Inch, USB.
- Select "Profile/Manage Profile"  /select Basic-D, 11 Inch, USB/ and press Edit
- In the "Page Layout" (Page Size) select 11 Inch paper and press Update Profile
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Repeat this setup sequence to personalize the other 3 profiles.

Set as Default Profile
Choose one of these default
profiles (the Basic-D, 11 inch) as
the default used without any
active selection. 

Select "/Profile/Manage Profile",
press Set as Default

Use the Profile
Select profile in the print dialog in "File/ WinBraille/ Emboss" or when you open a new document in
WinBraille.

Example: Select a profile when
you create a new document in
WinBraille

Select a profile when you emboss
from Word or Excel,  select "File/
WinBraille/ Emboss" in the print
dialog that pops up and press OK.

When you emboss from other
Windows application the default
profile will be used.
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7 Tools

7.1 Index Setup

Start Index Setup from the Windows Start menu: Start/ Programs/ Index Braille/ WinBraille/ Index
Setup 

The Index Setup program provides the following functions:
1. Install a Custom Installation Package from the Index CD, language and distributor specific. 

See Installing a Custom Installation Package.
1. Make a backup of your personal WinBraille setting.
2. Recover your personal WinBraille settings.
3. Make a Distributor Custom Installation Package, including contact details and logo. 

See Creating a Custom Installation Package.

7.1.1 Version

Version:2005-02-02

7.1.2 Installing a Custom Installation Package
 

A Custom Installation Package is a package of profiles, templates and contraction rules that you can select
for a specific market, locale or application. Run Index Setup to install a default profile for your installation
of WinBraille. Select one of the available packages, or browse to the location of your custom installation
package.
 

 

 

Most packages have more than one option. Press Next to open the selected packet and select one of the
package's options.
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The "Index Default Installation Package" contains five options, one for each embosser model and one
package with profiles for all Index Embossers. If only one model has been installed,  select that model. If
more than one model has been installed, select "All Index Embossers". Press Finish to end the custom
installation.
See Default Profile Settings for the settings in the "Index Default Installation Package".

7.1.3 Creating a Custom Installation Package

Follow the following step by step description to create a custom installation package:
Task Action Comments

1 Use WinBraille to set up a Profile, a Template, a Translation File and an Exceptions list on your
computer.

2 Check  your personal settings before starting the Index Setup program. It is not possibly to make any
changes to the WinBraille settings during the creation of a personal custom installation package.

3 Start Index Setup program C:/ program/ Index/ WinBraille/ Index Setup

4 Create Select "Create a New Custom
Installation Package" 
Press Next

Create a new package.

5 Welcome Press Next
6 Custom

Installation
Package

Select "New Package"

7 Type a Package
Name

Type a file name 
Press New

File name convention "country distributor.wcp"
Insert the file name of your personal setup file.

8 Type a name Type a package name 
Press Next

File name convention "country distributor", same as
the file name

9 Save your
Custom
Installation
package

Press Next to save the
package

Save your Custom Installation package

10 Retailer 
Information

Select "No retailer
information" 
Press Next

Retailer information is added by Index support
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11 Package Option Select type of "Multi Option
Package" Press Next

Multi Option Package = Several embossers are
installed in the package, selectable when installing
the custom Installation Package 
Multi Option Package (not tagged) = A complete
package without selection during installation

12 New Option Type "Option Name" 
Press Next

Name Convention: "Embosser Name", example
Everest USB, 4X4 PRO Network

13 Include Profiles
in the Setup

Click to Select Profile (-s)
Press Next 

The installed profiles in WinBraille can be selected

14 Save Custom
Installation
Package

Select default profile 
Press Save 

15 Repeat for more
embossers

Press Back until the "Page
Option" (three times) 
Repeat step 11-14

To create similar packages for more embosser
models:

16 Saved Custom
Installation
Package

Press Finish to save the
package

Package saved at: C:\programs\Index Braille\
WinBraille\ Install\ "file name.wcp" (country
company.wcp).
Select your "package name" in Index Setup to
re-install your personal WinBraille settings. 

7.2 Index Add Printer Wizard

The Index Add Printer Wizard is available from the Tools menu in WinBraille and also from the Program
Folder. 
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7.2.1 Installing an Embosser locally

Installing an embosser locally

The installation process guides you through the installation of the embosser. This is performed with the help
of the Add Printer Wizard. (You can run this wizard later from within WinBraille any time if you need to
install another Index Embosser). The wizard contains a couple of pages. Read the information on each page,
enter requested information, and press Next. You need the following data about your embosser to finish the
wizard:
· The embosser model (Everest, Basic-S, Basic-D, 4x4 PRO or 4Waves PRO)
· Where you have connected the embosser, i.e. the port (Serial, Parallel, USB, Network or TCP/IP)
· If you connect the embosser through a TCP/IP port, you also need to enter the embosser's TCP/IP address

7.2.1.1 Installing an embosser connected to a local parallel port

Press Next to go to the second
page. In this example the
embosser shall be connected
to the local LPT1 parallel port.
Check the "Local" selection.

The WinBraille driver option
is marked per default. Do not
change the WinBraille driver
port unless agreed with Index
support. 

Note: The "WinBraille driver"
selection is greyed if the driver
is already installed on the
computer. Press Next.

4876x3349 pixels (displayed at 2438x1675)4876x3349 pixels (displayed at 2438x1675)

Select the printer port on page
three. Select LPT1 and Press
the Next.

4876x3349 pixels (displayed at 2438x1675)4876x3349 pixels (displayed at 2438x1675)
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The fifth page gives an
option to name the embosser.
The default name is the same
as the model.  Type a
suitable name for your
embosser, in this
example"Pluto-4x4"

On page six, you can decide
whether you want to share
your embosser with others. If
you decide not to share,
leave the settings as they are
and press Next.

The last page shows the
settings you have made for
your embosser. Press Finish
to complete the installation.
The drivers will now be
copied and installed. This
can take a while.

4876x3349 pixels (displayed at 2438x1675)4876x3349 pixels (displayed at 2438x1675)

7.2.1.2 Installing an embosser connected to a local serial port

To connect the embosser to
one of the serial ports follow
the description for Installing an
embosser connected to a local
parallel port except for the
selection of the port which
should be a serial port in the
system. After the installation is
finished, open the Printer
folder and select "Properties"
for the installed Embosser.
Select the "Port" tab and press

the "Configure Port" button.

The communication parameters differ between Version III embossers and version II embossers (Embossers
with serial number below 30 000). For recommended values see below
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Parameter Version II Version III
Baud rate 9600 38400
Data bits 8 8 
Parity None None
Stop Bits 1 1
Handshake Hardware Hardware

Note!
The communication parameters in the embosser and in this dialog must match.After setting up the driver,
verify that the settings in the embosser consist with the settings made in the port configuration dialog. From
the embosser front panel, press Setup. Press Group until the Embosser echoes "Communication". Use Item
and Value to change the settings according to the settings in the Port configuration dialog. 

For version III Embossers, the embosser item "Serial Mode" must be set to "Print".

7.2.1.3 Installing an embosser connected to a local USB port

Follow the description for Installing an embosser connected to a local parallel port except for the selection
of the port which shall be the USB port. The behavior of the Index Add Printer Wizard differs depending on
if a USB port exist in the system before the installation start or not. 
On windows 2000/XP the installation is straightforward. Depending on which operating system you have
Windows sometimes need to know where to find the driver location. In that case always select the
"..\Program Files\Index Braille\WinBraille" folder and follow the instructions.

7.2.1.4 Installing an embosser to a network port

Follow the description for Installing an embosser connected to a local parallel port except for the selection
of the port which should be the TCP/IP port that exist in the system. When the installation is completed, run
the Index Embosser Utility to update the IP settings in the Embosser. See also the Index Braille Embosser
Manual.
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7.2.2 Installing a Network embosser

Installing a network printer on a client requires that the shared printer has already been installed on a server
or a Workstation. For more information see "The Printer sharing dialog". After the "Welcome" dialog the
"Local or Network" dialog is displayed. 

Check "Network" and press Next.

Browse for your printer and press OK. Note that it is only possible to select Index Embosser printers. OK
will be disabled for all printers except Index Braille Printers
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After the Installation is finished check that the Embosser has appeared in the Printer folder. Note the line
below the printer, indicating that it's a network printer.

7.2.2.1 Embosser connected to Windows 2000 Workstation or Server

If the printer is connected to a Windows 2000 Workstation or Server, you should not install WinBraille.
Instead you should install a local Index Braille Printer that is shared to the Network users. Run the Index
Add Printer Wizard and select the driver from the Drivers folder on your Index CD. 

7.2.2.2 Embosser connected to a Print Server

If you want to connect an Index Braille Printer to a Print Server in your Network you must first install and
configure the Print Server. To install and configure a Print Server please refer to the documentation for the
Print Server.

When you have added the Print Server as a local port on a Server, Workstation or Client you can proceed
with the printer installation as per the appropriate section above depending on the operating system. During
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the local installation of WinBraille you should be able to see the Print Server in the list of local ports.

7.3 WinBraille Image Editor

7.3.1 Introduction

The WinBraille Image Editor is a tool for creating and editing tactile images. It is distributed as an
integrated part of the WinBraille Braille Editor.

7.3.2 Overview

This document covers:
· How to use the image editor from a document in WinBraille
· The image editor as a stand-alone tool
· Working with the WinBraille Image Editor
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· Reference

7.3.3 How to use the editor from a document in WinBraille

WinBraille documents (starting with WinBraille version 4) can contain images. You can for example open a
Word document, or emboss a document from Word, and transfer all images to the embosser. You have to
convert most images to Braille before you emboss them, though. Here's where the Image Editor comes in.

This section describes how you can use the Image Editor to convert your images to a suitable form so you
can emboss them on your embosser. First, start WinBraille and create a new empty document. We presume
in the rest of this section that you are familiar with WinBraille and know how to create a new document,
know how to translate the document to Braille, and know how to send it to the embosser.

You create or insert images in the source document. You have no option to insert new images into the
translated document once the document has been translated to Braille.

7.3.3.1 Insert an image in a document

You insert images with the "Insert - Image - From File" menu option in WinBraille. The image will be
placed in the document at the current cursor position. Note that you can only insert images in the source
document.

Browse to a folder with images and select an image.
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The image might not fit properly in the source document, but remember that the embossed paper size and
image size differ, some times considerably, from the sizes in the source document. You will probably resize
the image later to get a size that is more suitable to be embossed as a Braille image.

7.3.3.2 Insert a TGD image

You can include images in TGD PRO's image file format SIG in your document. However, Microsoft Word
does not recognize this image format. The image must be converted to a format that Word can recognize,
otherwise you can not save the document neither in the Word's "doc" format nor as a WinBraille "wif"-file
(in which case the document proper is stored with the "doc" format inside the "wif" file). WinBraille
performs this conversion automatically, but you have to supply some information that WinBraille needs for
the conversion.
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You insert a TGD PRO SIG file with the "Insert - Image - From File" menu, in the same way as you insert
images in other formats.

Select the TGD PRO SIG image file type:

An extra dialog box pops up. You have to supply some information that WinBraille needs to load the image
properly.
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The dot resolution (distance between each individual dot) will affect the size of the converted image. Select
0.5 mm if you will likely type Braille in the image. Otherwise you can select one of the three other options.
1.6 mm resolution makes the smallest size. 2.5 mm makes the largest.

You should select "Crop precise" or '"Crop with margins" if the dots only cover a part of the image. (Most
TGD PRO images cover a whole page, even though the image proper does only cover a fraction of the
image).

7.3.3.3 Create a new image

New images are created with the Image Editor. WinBraille automatically invokes the Image Editor and
opens the "New Image" dialog when you select the "Insert - Image - New" menu option in WinBraille.

Supply proper values in the "Width" and "Height" fields. The values are in mm, with a resolution in 10th of
mm. Select a suitable dot resolution for your image. Available resolutions are:

· 0.5 mm (2.0 mm with Braille)
· 1.6 mm
· 2.0 mm
· 2.5 mm

Select 0.5 mm resolution if you are going to mix Braille text and graphical dots in the same image. (0.5 mm
is the least common resolution for dots in a Braille cell, which are separated with a distance of 2.5 and 3.5
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mm, and graphical dots, which have a resolution of 2.0 mm in this option).

Select one of the options 1.6, 2.0 or 2.5 mm resolution if the image will not contain any Braille text. The 1.6
mm resolution creates the smallest size, while the 2.5 mm creates the largest.

7.3.4 Working with the Image Editor

The main purpose of the Image Editor is to convert color images to tactile images. The recommended
procedure to achieve this is:
1. Open an existing image or create a new (or double click on the image if you are in WinBraille and you

are editing a converted document with images).
2. Resize the image to a suitable size for a tactile image.
3. Eventually filter the image (the result is sometimes better if the color image is inverted before it is

converted).
4. Convert the image, either directly, or with the Outline function.
5. Change the parameters in the Convert dialog if necessary.
6. Use the tools to polish and finish the image.
7. Eventually add "letter font" text with the "Black Text" tool or Braille text with the "Braille" tool.
8. Save the image.

7.3.4.1 The Convert Dialog

A dialog box pops up when you select either "To Tactile Image" or "Outline" from the Convert menu. This
dialog contains some settings for the performance of the conversion. It is almost always necessary to adjust
at least some of the parameters to get a good result.
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The "Black and White Threshold" sets the gray level threshold between the black dot and the white
background. The "Color to Gray Blend Filter" can be used to filter and emphasize a specific color in the
image. The small box with axes marked with "I" and "H" in the upper right corner gives a hint about the
filter parameters.
One of four sets of standard filter parameters can be selected with the buttons "Gray", "R" (Red), "G"
(Green) and "B" (Blue).

The Outline function is performed in two steps. Step one performs the outline function on the color image. 
Step two converts the outlined image to a tactile image.
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7.3.5 Reference

7.3.5.1 Image Editor Menu

The Image Editor's functions are organized in nine menu groups.

The File menu contains standard Windows functions to open, create and save images. The File menu also
contains the preferences settings. Preference settings define the editor's behaviour on startup.

The Edit menu contains the undo and redo functions and functions to copy and paste parts of the image to
and from the clip board.

The View menu controls how images are displayed on the screen.

The Filter menu contains four functions to manipulate the original image and one function to manipulate the
tactile image. Functions that apply on the original color image are:

· Convert to gray scale
· Convert to black and white
· Outline the image, i.e. produce an image where the borders between dark and light fields are drawn.
· Invert the color image

The function that apply on the tactile image is:
· Invert the tactile image

The Convert menu contains the functions that actually convert the original image and produce a tactile
image. Two functions are supplied, "To Tactile Image" and "Outline".

 The Convert menu also contains a function to define the currently active image's type, whether it is a color
image or a tactile image. All images are stored in a Windows standard bitmap format. There is no
information in the image that tells whether it is a color image or a tactile image. The Image Editor uses a
more or less intelligent method to determine the image's type when you open an existing image. This method
is not actually stone-proof. If it fails, use the "Convert - Image Type" to change the type of the image to the
correct type.

The Resize menu contains two functions to resize the image. One for the original color image, and one for
the tactile image. Use the "Resize - Tactile Image" when you resize tactile images, so the size of the dots are
maintained. (The dots would otherwise be re sized as well).

Use the Tools menu to select the drawing tool. Available tools are: Pencil, Line, Brush, Fill, Circle, Filled
Circle, Rectangle, Filled Rectangle, Black Text, Braille, an Ereaser, and a Select box. The Tools menu also
contains a function to select the brush and eraser size, and a function to select one of fourteen fill patterns.

The Window menu contains the standard Windows Tile, Cascade and Arrange items. The Window menu
also contains a Redraw function. Not all functions redraw the images completely after every operation, since
redrawing large images can take a considerable time. It can be annoying to wait while the image is redrawn
after every operation if it is performed often.

The Help menu contains the standard "Help Topics" and the "About" information.
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7.3.5.2 Image Editor Tool Bar

The Tool Bar contains the three most used functions from the file menu: New, Open and Save, and the
twelve available tools: Pencil, Line, Brush, Fill, Circle, Filled Circle, Rectangle, Filled Rectangle, Black
Text, Braille, the Ereaser, and the Select box.

· Use the left mouse button to draw on the image with the selected tool.
· Use the right button with the Pencil and the Line tools to erase what you just draw.
· The right button selects the brush size for the Brush and the Eraser tools and the pattern for the Fill

tool.

7.3.5.3 Image Editor Status Bar

The Status Bar has four display fields. The first field shows the cursor's position in mm from the upper left
corner of the image. The second field contains information about the image resolution. The third field
displays the image's size in mm. The last fourth field contains information about the zoom factor.

7.4 The Rule File Editor

7.4.1 Menu Reference

Use the WinBraille Rule File Editor Ibrfe.exe to edit and compile WinBraille Rule Files. The menus in Ibrfe
are: "File", "Edit", "Search", "Rule File", "Font", "Help":

4620x2604 pixels (displayed at 2313x1300)4620x2604 pixels (displayed at 2313x1300)
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7.4.1.1 File Menu

All menu items except "File/Import S10 Braille code" are standard selections. You use the "File/Import S10
Braille code" to import Index Braille's S10 Braille Code files:

4620x2604 pixels (displayed at 2313x1300)4620x2604 pixels (displayed at 2313x1300)

You must supply a DOS code page when you import an S10 file:

4044x3411 pixels (displayed at 2025x1706)4044x3411 pixels (displayed at 2025x1706)

The selected code page determines how the characters in the S10 file are interpreted. The following
conversion alternatives are currently available:
· MS-DOS 866 Cyrillic – Text compatible with Windows 1251 Cyrillic code set
· MS-DOS 437 Latin US – Text compatible with Windows 1252 ANSI code set
· MS-DOS 850 Latin 1 – Text compatible with Windows 1252 ANSI code set
· MS-DOS 852 Latin 2 – Text compatible with Windows 1250 Eastern Europe code set
· No conversion
You are also prompted to give a name to the resulting WinBraille rule file:
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4044x3411 pixels (displayed at 2025x1706)4044x3411 pixels (displayed at 2025x1706)

The created rule file can be seen as a template. In most cases you must edit the file manually to get a
satisfying result.

The "File" menu alternatives "New rule file", "Open rule file", "Save", "Save as..." and "Print..." all use the
standard Windows dialogues for opening and saving files and for printing. The texts in the these dialogues
will therefore be in the local Windows language, as seen in the pictures above and below. This screen
capture was taken when the Rule File Editor was run under a Swedish version of Windows.

4139x2897 pixels (displayed at 2069x1450)4139x2897 pixels (displayed at 2069x1450)
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7.4.1.2 Edit Menu

The "Edit" menu has the standard menu alternatives: "Undo", "Cut", "Copy", "Paste", "Delete" and "Select
All".

4620x2604 pixels (displayed at 2313x1300)4620x2604 pixels (displayed at 2313x1300)

7.4.1.3 Search Menu

The "Search" menu provides functions to search and replace text in the file. Available menu alternatives are:
"Find...", "Find Next" and "Replace..."

4876x3074 pixels (displayed at 2438x1538)4876x3074 pixels (displayed at 2438x1538)

The search and replace functions use Windows standard dialogues. The texts in these dialogue boxes are
therefore in the local Windows language, as shown in the example below.
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3317x1577 pixels (displayed at 1656x788)3317x1577 pixels (displayed at 1656x788)

7.4.1.4 Rule File Menu

When you edit a new rule file, or open and change an existing file, the status line will have a red field with
the text "RuleFile filename NOT Compiled" to indicate that the rules in the editor need to be compiled for
the binary .ibk-file to be updated with the new changed information:

4876x3074 pixels (displayed at 2438x1538)4876x3074 pixels (displayed at 2438x1538)

When you have changed the text in the file, the only available menu alternative in the "Rule File" is
"Compile Rule file":

4876x3074 pixels (displayed at 2438x1538)4876x3074 pixels (displayed at 2438x1538)

During the compilation, a dialogue with an indicating bar will be shown. You can interrupt the compilation
and discard the changes by clicking on the "Stop" button.
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2476x478 pixels (displayed at 1238x238)2476x478 pixels (displayed at 1238x238)

When you have compiled the file, the red status field will be switched to green, with the text "RuleFile
filename Compiled".

4876x3074 pixels (displayed at 2438x1538)4876x3074 pixels (displayed at 2438x1538)

In this state the "Rule File" menu has two other alternatives: "Test rule file 'on the fly'" and "Test rule file by
converting a text file":

4876x3074 pixels (displayed at 2438x1538)4876x3074 pixels (displayed at 2438x1538)

The "Test 'On The Fly'" dialogue has two options: "Edit Unconverted Text" and "Edit Converted text". With
the "Edit Unconverted Text" option, you can type text in the "Original Unconverted Text" window. The
converted text will appear both as "Converted Black Text" and as "Converted Braille Text".

The "Edit Converted Text" gives you the possibility to select "Converted Black Text" and see the
corresponding "Converted Braille Text". Nothing will appear in the "Original Unconverted Text" window,
though, since back translation is not performed.  With this dialogue, you can immediately test the rules and
see how they interpret the typed text and how the converted text will be shown on the screen.
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7.4.1.5 Font Menu

The "Font" menu makes it possible to change font in the editor. This is useful when you create rule files in
foreign languages.

4876x3074 pixels (displayed at 2438x1538)4876x3074 pixels (displayed at 2438x1538)

The "Font" option uses the standard Windows font dialogue. All text will therefore be in the local Windows
language, as shown in the screen capture below.

3789x3047 pixels (displayed at 1894x1525)3789x3047 pixels (displayed at 1894x1525)
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7.4.1.6 Help Menu

The last menu, "Help" has two options, the "Help" option and the "About Rule File Editor..." option.

4876x3074 pixels (displayed at 2438x1538)4876x3074 pixels (displayed at 2438x1538)

The "About Rule File Editor..." selection displays a dialogue with the copyright information and version
number of the Rule File Editor.

The "Help" selection opens the Windows Help for the WinBraille Rule File Editor.

7.4.2 Example on how to use the Rule File Editor

Use American Grade 0 (rule file american_g0.ibk). Type the small letters "abc" followed by a capital "A" in
the "Original Unconverted Text" field. (The option "Edit Unconverted Text" is selected).

4876x1931 pixels (displayed at 2438x963)4876x1931 pixels (displayed at 2438x963)

A capital prefix is automatically inserted. Proceed with the capital letters "BC", and note that the single
capital prefix is replaced with a multi-capital prefix:

4876x1931 pixels (displayed at 2438x963)4876x1931 pixels (displayed at 2438x963)
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Repeat this using the "Edit Converted Text" option.

4876x1931 pixels (displayed at 2438x963)4876x1931 pixels (displayed at 2438x963)

Type the letters "abc", followed by a comma. (The capital prefix in American grade 1, dot 6, corresponds to
a comma in American grade 0, which is used as the Black Text coding).

4876x1931 pixels (displayed at 2438x963)4876x1931 pixels (displayed at 2438x963)

End with the small "a", and you receive the same result as if you had typed "abcA" in the "Original
Unconverted Text" field. If you want to type the "Converted Black Text" that corresponds to the "Original
Unconverted Text" "abcABC", you have to manually insert a second comma to represent a multi-capital
prefix.

4876x1931 pixels (displayed at 2438x963)4876x1931 pixels (displayed at 2438x963)

The menu alternative "Test rule file by converting a text file" gives a possibility to do exactly what the menu
says. Given a text file, you can load it into the Rule File Editor and apply rules to the whole file. After you
have loaded the file, you have three more menu alternatives: "Convert Text File to Black Text", "Convert
Text File to Braille" and "Return to RuleFile". The latter is used to exit the text file and return to the rule
file.
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4876x3074 pixels (displayed at 2438x1538)4876x3074 pixels (displayed at 2438x1538)

Convert the text File to black text with the alternative "Convert Text File to Black Text":

4876x3074 pixels (displayed at 2438x1538)4876x3074 pixels (displayed at 2438x1538)

Convert to Braille with the alternative "Convert Text File to Braille":

4876x3074 pixels (displayed at 2438x1538)4876x3074 pixels (displayed at 2438x1538)
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7.5 IbPrint

The utility IbPrint is a small application for embossing documents directly to an Index Braille Embosser.
See Embossing using IbPrint for details on how to emboss documents.

7.6 Embosser Utility

You use the Embosser Utility to maintain the Index Embosser, thus it is described in the Index Braille
Embossers Manual.
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8 WinBraille Menu Reference

8.1 Menus

WinBraille has 13 menu items: File, Edit, View, Insert, Format, Table, Document Options, Braille, Window,
Internet, Tools, and Help.

WinBraille is available in two editions, a standard edition and a professional edition. The editions differ in
the number of available menu items. Manipulation of styles and templates are disabled in the standard
edition, thus all menus that manipulate styles and templates are not available in the standard edition.
 

The source and Translated document menus
The source and the translated documents have associated pop-up menus you can open with the right mouse
button when you hover the mouse over a document. 

The source document menu contains 15 of the most usable menu items from the main menu.
 

 
 
The translated document menu contains eight of the most usable menu items from the main menu.
  

 
 

8.2 The File Menu

8.2.1 New...

Command Key: Ctrl + N
Available: Always
  
This menu item opens a dialog  "Create New Document", that allows you to create a new empty document,
based on one of the profiles that is currently available in the WinBraille system.



71WinBraille Menu Reference

Index Braille AB

 
 
The dialog contains the following controls:

· A list control with all profiles available in the system.
· A check box "Edit translated document". Mark this box if you only want to create a Braille document and

don't want a source document.
· OK. Creates a New Document, based on the currently selected profile.
· Cancel. Cancels the operation.

The default selection will always be based on the profile that is chosen as the "Default Profile". A newly
installed system only has one profile, called "Embosser Name", "Default". Use your arrow keys to navigate
to the preferred profile and use the TAB key to select OK.

8.2.2 Open...

Command Key: Ctrl + O
Available: Always
 
This menu item opens the "Open" dialog, which allows you to open a document in WinBraille. The layout of
the dialog depends on the operating system you are using. In the English version of Windows 2000, the
Open dialog looks like:
 

 
 
WinBraille supports the following formats:
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  Format File Extension
  ASCII Files TXT
  HTML Files HTM,HTML
  Rich Text Files RTF
  WORD Files DOC
  WinBraille Files WBR
  WinBraille Template File WTF
  WinBraille Project File WIF

Select the Edit source document radio button if you want to open the document as a source document. 
Select Edit translated document if you want to open the document translated to Braille. If you select Edit
translated document, and open a source document, the document will be automatically translated before it is
displayed. The source document will not be available after translation.
The "Select Profile" list box displays the profile that will be used when opening the document. It is possible
to select any profile installed in the system.

8.2.3 Save

Command Key: Ctrl + S
Available: When a document is opened and modified

Saves the contents of a file you are editing to a disk file.

8.2.4 Save As...

Command Key: None
Available: When a document is opened

Saves the contents of a file you are editing to a disk file.
This menu item opens the "Save As" dialog, that allows you to save the document to a disk file. The layout
of the dialog depends on the operating system you are using.

8.2.5 Save Project

Command Key: None
Available: When a Project document is opened

The Save Project menu item will save all documents that belong to the project.

8.2.6 Save As Project...

Command Key: None
Available: When a document is opened

The Save as Project function saves the document with all its opened connected documents as a project. The
project is saved as a "WIF" file. (WinBraille Interchangeable Format).
 
This menu item opens the "Save As Project" dialog. This dialog allows you to save the document(s) as a
Project. The layout of the dialog depends on the operating system you are using. The source document and
all corresponding translated documents will be stored in the project, together with the profile, the template
and all referenced translation files and exception files. The WIF file can be used to transfer a project from
one WinBraille system to another system.
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8.2.7 Save As Template...

Command Key: None
Available: In the professional edition, when a document is opened

The Save as template function will save the document as a WinBraille Template. The template file is stored
in the Template directory.

8.2.8 Close

Command Key: Ctrl + F4
Available: When a document is opened
 
This command will close the active document without closing the application.

8.2.9 Close Project

Command Key: None
Available: When a Project document is opened
  
This command will close the active document and all other documents that belong to the same project file,
without closing the application.

8.2.10 Close All

Command Key: None
Available: When a document is opened
  
This command will close all documents without closing the application.

8.2.11 Page Setup...

Command Key: None
Available: When a document is opened
  
This command will open the dialog Page Setup. The Page Setup dialog is used to set paper size, orientation
and document margins.
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8.2.12 Print...
 

Command Key: Ctrl + P
Available: When a document is opened
  
The Print dialog gives you the possibility to print a source document or a translated document to any printer
connected to your system, except Index Braille Embossers. Printing a translated document (Braille view) can
be useful for educational purposes. The dialog contains several controls, which gives you the possibility to
change some settings before you print the document.
 
· Select Printer: A list box containing all printers in the system, except Index Braille Embossers.
· Printer Details: A field with information about current selected printer. Your administrator can fill in this

field, in order to give you some useful information about for example the location of the printer, etc.
· Copies: Number of copies to print.
· Print to File: When this option is selected, a dialog box will be displayed after you have pressed the OK

button. The new dialog will query about the printout file name.
· Group Box, Print Range: Contains 3 controls for selecting the page range:
· All Pages: Select this option if you want to print the whole document.
· Selected Pages: When this option is selected, 2 extra controls are enabled; "From Page" and "To Page".

Fill in the appropriate page range and press the OK button to print the selection of the document.
· Current Page: Just print the current page.

 

 
 

8.2.13 Emboss...

Command Key: Ctrl + B
Available: When a document is opened
 
The Emboss dialog gives you the option to change several settings before you emboss the document to your
Index Braille Embosser. If the Document is not translated, a translation of the source document is performed
before the dialog is displayed. If the active document is a source document and a translated document exists
that the user has edited, a new translation is started before it is embossed. If the user has not edited the
translated document, WinBraille will switch to that Window and emboss it without any prior translation.
Below there is a description of all controls in the dialog. 
 
· Select Printer: A list box containing all printers in the system, except Index Braille Embossers.
· Printer Details: A field with information about current selected printer. Your administrator can fill in this

field, in order to give you some useful information about for example the location of the printer, etc.
· Copies: Number of copies to print.
· Print to File: When this option is selected, a dialog box will be displayed after you have pressed the OK



75WinBraille Menu Reference

Index Braille AB

button. The new dialog will query about the printout file name.
· Group Box, Print Range: Contains 3 controls for selecting the page range:
· All Pages: Select this option if you want to print the whole document.
· Selected Pages: When this option is selected, 2 extra controls are enabled; "From Page" and "To Page".

Fill in the appropriate page range and press the OK button to print the selection of the document.
· Current Page: Just print the current page.

 

 
 

8.2.14 Preview...
 

Command Key: None
Available: When a document is opened
 
The Preview command opens a dialog box and displays the document, as it will be printed on the paper. The
dialog has 4 buttons: Print…, Prev Page, Next Page and Close.
 
· Print…: Open the Print dialog to print the document.
· Prev Page: Display the Previous page.
· Next Page: Display the Next Page.
· Close: Close the preview dialog.
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8.2.15 Exit

Command Key: None
Available: Always
  
The exit command closes all opened documents and exits WinBraille.

8.3 The Edit Menu

8.3.1 Undo

Command Key: Ctrl + Z
Available: When a document is opened and you have edited the document
 
Undo the last operation.

8.3.2 Redo

Command Key: Ctrl + Y
Available: When a document is opened and you have edited the document
  
Redo the last operation.
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8.3.3 Cut

Command Key: Ctrl + X
Available: When a document is opened

Cut the current selection and place it in the clipboard.

8.3.4 Copy

Command Key: Ctrl + C
 
Available: When a document is opened

Copy selected text to the clipboard.

8.3.5 Paste

Command Key: Ctrl + V
Available: When a document is opened and the clipboard is not empty
 
Paste the content in the clipboard to the current insertion point in the document.

8.3.6 Paste And Translate

Command Key: Ctrl + W
Available: When a document is opened and the clipboard is not empty
 
Paste the content in the clipboard to the current insertion point in the document. The content in the clipboard
is translated according to the current profile.

8.3.7 Delete

Command Key: Del
Available: When a document is opened
  
Delete current selection.

8.3.8 Select All

Command Key: Ctrl + A
Available: When a document is opened
  
Select the complete content of the  current document.

8.3.9 Find...

Command Key: Ctrl + F
Available: When a document is opened and the document contains text

Open the Find dialog box, which makes it possible for you to find text in the current document.
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8.3.10 Replace...

Command Key: Ctrl +HF
Available: When a document is opened and the document contains text
 
Open the replace dialog box, which makes it possible for you to replace text in the current document.
  

 

8.3.11 Go to Page...

Command Key: Ctrl + G
Available: When a document is opened
 
This command opens the "Goto Page" dialog. The purpose of this dialog is to get a fast way to go to a
specific page, without using the scroll bars or the movement keys.
The dialog contains 5 controls:
Last Page Displays the last page in the document.
Current Page Displays the current Page.
New Page The field to type your new page.
  

 
 
When the dialog is displayed, the active control will be the New Page control. Use your arrow key to select a
new page or type directly in the field. The default page is always the current page.

8.4 The View Menu

8.4.1 Normal Page Layout

Command Key: None
Available: Always

WinBraille offers two different page modes: Normal Page Layout and Centered Page Layout.

The document pages are displayed with gaps, borders, margins and a gray background. The number of pages
depends on the text.
  



79WinBraille Menu Reference

Index Braille AB

 

8.4.2 Centered Page Layout

Command Key: None
Available: Always

WinBraille offers two different page modes: Normal Page Layout and Centered Page Layout.

This view works in the same way as the page view, but WinBraille displays three-dimensional pages, which
are cantered in the window's client area.
  

 

8.4.3 Status Bar

Command Key: None
Available: Always
 
When this option is selected, WinBraille will display a Status bar at the bottom of the window and a Tool
bar at the top. 
 

The Tool Bar
The Tool bar displays the current style, font and font size.
  

 
 

The Status Bar

The Status bar displays important navigation information.
The fields are from left to right:
· Page – Displays current page, starting with page 1.
· Line – Displays the current Line relative from the top of the page.
· Column – Displays the current column.
· Zoom – Displays the current zooming factor.
· Table – If the cursor is inside a table, this will display the current row and column.
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· Insertion mode – Displays INS when the editor mode is INSERT and OVR when the mode is
OVERWRITE.

· Macro – This filed displays information about the loaded macro, or the text "No Macro Loaded".
· Profile – Displays the name of the current profile, currently loaded contraction rules, and characters per

line and lines per page.
  

 
 

8.4.4 Translation Display

Activate the translation display to see the translation while you are typing in the source document, or to see
the original or back-translated text while you are typing in the translated document.

Display
Check "Show" to view the translation display. Check "Hide" to hide the display.

Performance
Some, but not all, translation rules can do both forward and back translations. Check the "Use
back-translation rules when possible" to enable the back-translation rules. 
Note: Enabling this feature can slow down the translation considerable.

WinBraille can present back-translated text with different colors for contractions, prefixes and un-contracted
text. Check "Use color scheme for back-translated rules" to turn on this feature.

Number of rows in the translation display
The figure below shows the display with the first line of text from a famous poem by Goethe.
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6283x2463 pixels (displayed at 3144x1231)6283x2463 pixels (displayed at 3144x1231)

The display can show one, two, three or four rows of information.
1 row: The display shows the original text, or the back-translated text if this feature is enabled.
2 rows: The display shows translated text in addition to the original or back-translated text.
3 rows: The display also shows the translated text in Braille.
4 rows: A comment is displayed in addition to the information in the other three rows.

8.4.5 Zoom

50%
 
Command Key: None
Available: When a document is opened
 
Set the zooming factor for current document to 50% of its original size.
 

75%
 
Command Key: None
Available: When a document is opened
 
Set the zooming factor for current document to 75% of its original size.
 

100%
 
Command Key: None
Available: When a document is opened
 
Set the zooming factor for current document to its original size.
 

50%
 
Command Key: None
Available: When a document is opened
 
Set the zooming factor for current document to 150% of its original size.
 

200%
 
Command Key: None
Available: When a document is opened
 
Set the zooming factor for current document to 200% of its original size.
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Page Width
 
Command Key: None
Available: When a document is opened
  
Set the zooming factor for current document so the window will display the whole width of the page.

Whole Page
 
Command Key: None
Available: When a document is opened
 
Set the zooming factor for current document so the window will display exactly one page.

8.4.6 Show white spaces

Command Key: None
Available: When a document is opened
 
This menu item will make space and paragraph end symbols visible.

8.4.7 Display All Help Messages

Command Key: None
Available: Always
 
This menu item will enable all help messages that have the check box "Don't show this message again".
 

 

8.4.8 Professional Edition

Command Key: None
Available: When no documents are opened
 
This menu item will toggle between professional and standard edition. In standard edition mode
manipulation of styles and templates are disabled. When activating professional mode, WinBraille will shut
down and restart with a new menu.

8.5 The Insert Menu

8.5.1 Insert Translated Text...

Command Key: Ctrl + F2
Available: When a translated document is opened
 
When the document is translated, extra text can be added as plain text and translated before it is inserted.
This menu item opens a dialog box where you add your text. Press OK to translate the text and add it at the
current input position in the translated document. 
 



83WinBraille Menu Reference

Index Braille AB

 

8.5.2 Page Break

Command Key: Ctrl + ENTER
Available: When a document is opened
 
Insert a new page at current input position.

8.5.3 Insert Image

Command Key: None
Available: When a source document is opened
 
Insert an image at the current input position.

From File..
Opens a File dialogue. Use it to browse to the image file and press Open.

New
Starts the Image Editor. See the Image Editor.

8.6 The Format Menu

8.6.1 Character...

Command Key: Ctrl + D
Available: When a source document is opened
 
This menu item opens a dialog box, which contains all available fonts and point sizes for the currently
selected printer. Font attributes and values for subscript and superscript can also be set.
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The dialog consists of font, font size and three groups of controls: Attributes, Position and color.
 

Attributes
 
This group of controls is used to set the following attributes:
· Bold
· Italic
· Strike out. Draws a horizontal line across the characters.
· Normal. Removes the above mentioned attributes.
 

Position
· Normal. The horizontal position is normal.
· Superscript. When this option is set, an extra field is enabled, giving you the possibility to exactly set the

new height above the text line in points.
· Subscript. When this option is set, an extra field is enabled, giving you the possibility to exactly set the

new height below the text line in points.
 

Color
· Text. The text list box is used to set the color of the text. The list box contains the system's standard

colors.
· Other. The button "other" opens the standard color dialog with a larger selection of colors.
· Text Background. The Text Background list box is used to set the background color of the text. The list

box contains the system's standard colors.

8.6.2 Paragraph...

Command Key: None
Available: When a document is opened
 
This menu item opens a dialog box, which can be used to set attributes for all currently selected paragraphs. 
 
The available attributes depends on if it is a source document or a Braille document.
For a source document, the attributes are line spacing, alignment, indents and the distance to the previous
and the following paragraphs. All values are set in millimeters; the value for line spacing can be set either in
millimeters or as a multiple of the font size.
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For a Braille document, the attributes are indent and alignment. All values are set in characters.
 

 

8.6.3 Bullets and numbering

Command Key: None
Available: When a source document is opened

The Bullets and numbering menu item contains the following sub menu items:
· Attributes
· Increase Level
· Decrease Level
· 1,2,3
· A,B,C
· a,b,c,
· I,I,I
· i,i,i
· Bullet
· None

8.6.3.1 Attributes

Command Key: None
Available: When a source document is opened
 
This menu item opens a dialog box, which can be used to set the attributes for all selected paragraphs. The
dialog box contains four group boxes; Bulleted/numbered, Bullet character, Number format and Formatting.
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Bulleted/Numbered
 
This group of controls contains the buttons None, Bullet and Numbered:
· None, Remove numbering or bullets for all selected paragraphs.
· Bullet, Set all selected paragraphs to bulleted lists. The group box Bullet character will be enabled, giving

you the option to change the size and appearance of the bullet character.
· Numbered, Set all selected paragraphs to numbered lists. The group box Number Format will be enabled,

giving you the option to change the number format.
 
Command Key: None
Available: When a source document is opened

This menu item will set the selected paragraphs to normal paragraphs.

8.6.3.2 Increase Level

Command Key: None
Available: When a source document is opened
 
This menu item will increase the level of numbering for all selected paragraphs. See example below:
Before:

1.First Item
2. Second Item
3. Third Item

After:
1.First Item
2. Second Item
3. Third Item

8.6.3.3 Decrease Level

Command Key: None
Available: When a source document is opened
 
This menu item will decrease the level of numbering for all selected paragraphs. See example below:
Before:

1.First Item
2. Second Item
3. Third Item
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After:
1.First Item
2. Second Item
3. Third Item

8.6.3.4 1,2,3

Command Key: None
Available: When a source document is opened
 
This menu item will set the selected paragraphs to a numbered list. The format will be Arabic numbers. 

8.6.3.5 A,B,C

Command Key: None
Available: When a source document is opened
 
This menu item will set the selected paragraphs to a numbered list. The format will be capital letters. 

8.6.3.6 a,b,c

Command Key: None
Available: When a source document is opened

This menu item will set the selected paragraphs to a numbered list. The format will be lower case. 

8.6.3.7 I,I,I

Command Key: None
Available: When a source document is opened

This menu item will set the selected paragraphs to a numbered list. The format will be Roman capital letters. 

8.6.3.8 i,i,i

Command Key: None
Available: When a source document is opened

This menu item will set the selected paragraphs to a numbered list. The format will be Roman lower-case
letters. 

8.6.3.9 Bullet

Command Key: None
Available: When a source document is opened

This menu item will set the selected paragraphs to a bulleted list. 

8.6.3.10 None

Command Key: None
Available: When a source document is opened

This menu item will set the selected paragraphs to normal paragraphs.
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8.6.4 Style...

Command Key: None
Available: When a source document is opened
 
This menu item opens a dialog box, which can be used to add, modify and delete any style in the document.
  

 
  

New Style
When pressing the "New…" button, the "New Style" dialog is displayed. The New Style dialog and the
modify dialog is similar except that some of the options in "Modify Style" is read only.
 

 
  
The "New Style" dialog contains several controls. A short description of the controls is given below after
Modify Style..

Modify Style
The Modify button opens the "Modify style" dialog. The "Modify style" dialog is where you change the
attributes for the selected style.
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The "Modify Style" dialog contains several controls. See below for more information.
 

Name
Type the name of the new style.
 

Based on
Defines from which style this new style should inherit the properties.
 

Style Type
The style can be of type Paragraph or Character. A Paragraph based style can only be set for the whole
paragraph in contrast to a Character based style. A Character based style can be set for a single character or
parts of a paragraph.

 
Font…
This button opens a dialog box. The font dialog box contains all available fonts and point sizes for the
currently selected printer. Font attributes and values for subscript and superscript can also be set. 

 
The dialog consists of font, font size and three groups of controls: Attributes, Position and color.
 
"Attributes"
This group of controls is used to set the following attributes:
· Bold
· Italic
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· Strike out. Draws a horizontal line across the characters.
· Normal. Removes the above mentioned attributes.
 
"Position"
· Normal. The horizontal position is normal.
· Superscript. When this option is set, an extra field is enabled, giving you the possibility to exactly set the

new height above the text line in points.
· Subscript. When this option is set, an extra field is enabled, giving you the possibility to exactly set the

new height below the text line in points.
 
"Color"
· Text. The text list box is used to set the color of the text. The list box contains the system's standard

colors.
· Other. The button "other" opens the standard color dialog with a larger selection of colors.
· The Text Background list box is used to set the background color of the text. The list box contains the

system's standard colors.
 

Paragraph…
The attributes are line spacing, alignment, indents and the distance to the previous and the following
paragraphs. All values are set in millimeters; the value for line spacing can be set either in millimeters or as a
multiple of the font size.

  

Line spacing
· Single line. The distance between two consecutive lines is exactly the text height.
· One and a half lines. 
· Two lines.
· Free. Give the number of free lines below the selected paragraph.
· In mm

Alignment
There are four options for setting the alignment of the paragraph:
· Left 
· Center 
· Right 
· Justified
 

Indents
Indents can be set in mm for left, right and first line
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Distance
Distance makes it possible to set the distance in mm from the text to top and to bottom

8.6.5 Tabs...

This menu item opens a dialog box, which can be used to set tabular stops for all currently selected
paragraphs.
 

 

8.7 The Table Menu

8.7.1 Insert...

The menu Table/Insert menu contains following sub-menu items:
· Table...
· Column to the Left
· Column to the Right
· Row above
· Row below

8.7.1.1 Table...

Command Key: None
Available: When a source document is opened

This menu item inserts a table at current insert position; by open a dialog box giving the user the option to
chose number of rows and columns. The dialog box contains four controls:
 

 
 

Columns
Enter the number of columns for the table by typing a numeric value or use your arrow key (up/down) to get
your value. The default value for a new table is 2 columns.
 

Rows
Enter the number of row for the table by typing a numeric value or use your arrow key(up/down) to get your
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value. The default value for a new table is 2 rows.
 

OK
 Insert a table at current insertion point, with the settings according to the dialog box.
 

Cancel 
 
Cancel the operation.
 

8.7.1.2 Column to the left

Command Key: None
Available: When a source document is opened
 
Insert a column to the right of the insertion point.
 

8.7.1.3 Column to the right

Command Key: None
Available: When a source document is opened

Insert a column to the left of the insertion point.

8.7.1.4 Row above

Command Key: None
Available: When a source document is opened
 
Insert a row above the current insertion point.

8.7.1.5 Row below

Command Key: None
Available: When a source document is opened
 
Insert a row below the current insertion point.

8.7.2 Delete

The menu item Table/Delete contains following sub-menu items:
· Table
· Columns
· Rows

8.7.2.1 Table

Command Key: None
Available: When the insertion position is inside a table
 
It is possible to delete a table when the insertion point is inside the table. This menu item deletes the whole
table including all of the table's paragraphs.
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8.7.2.2 Columns

Command Key: None
Available: When the insertion position is inside a table
 
Delete the column where the insertion point is.
 

8.7.2.3 Rows

Command Key: None
Available: When the insertion position is inside a table
 
Delete the row where the insertion point is.

8.7.3 Select

The menu item Table/Select contains following sub-menu items:
· Table
· Row
· Cell

8.7.3.1 Table

Command Key: None
Available: When the insertion position is inside a table
 
This command selects the whole table.

8.7.3.2 Row

Command Key: None
Available: When the insertion position is inside a table
 
This command selects the entire row.

8.7.3.3 Cell

Command Key: None
Available: When the insertion position is inside a table
 
This command selects the cell where the insertion point is. 

8.7.4 Gridlines

Command Key: None
Available: When a source document is opened
 
This command will activate grid lines for all tables. 
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8.7.5 Properties...

Command Key: None
Available: When a group of table cells is selected
 
This menu item opens a dialog box for setting the properties for the selected table.
  

 
 
The dialog box contains four groups of controls:
 

Frame
The frame group consists of two controls, one image control, displaying the frame layout, and one list box
containing the selectable line widths for each framing line. The frame image control displays the number of
selected cells. This means that if you have selected the whole table, the frame image control will display all
horizontal and vertical lines in the table.
 
Click on one of the lines in the image control and move to the line width control in order to set the width for
currently selected line. To set the width for only one cell you must select only that cell before you enter this
dialog.
 

Background
The Background group contains several controls for setting the background of the table. Note that affected
number of cells depends on how many cells you have selected before you entered the dialog.
 

Vertical Alignment
Chose the appropriate alignment.
 

Text distance
This group of controls defines the distance from the cell frame to the text inside the cell. The left, top, right
and bottom distances can be defined individually. All values are in points.
 

8.8 The Document Options Menu

8.8.1 Document Properties...

Command Key: None
Available: Always when a document is opened
 
The Document Properties will be displayed in a tabbed dialog box, showing preferences for the currently
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active document.
 
Because of the complexity of all options, the dialog box is built up with a category list on the left hand side
to view the corresponding category controls on the right hand side. The main Dialog for the profiles contains
following pages:
 
· Preferences – Preferences for the WinBraille application.
· Embosser – Contains the embosser connected to the profile and some embosser specific options.
· Page Layout – Page size for the translated document (the Braille document) and margins.
· Header – Header and footer for the Braille document.
· Graphics - How to treat images.
 

 
 
All menu items in the Document Options menu affect only the currently opened document, in opposite to the
items in the Profile menu. You use these options when you only want to change the behavior in prior to
embossing or translating the current document, since no changes will be stored to the profile or template.
 
All dialogs accessed from the Document Options menu are also available from the Profile menu, with the
exception of the Change Profile dialog. The only difference between the dialogs in the Document Options
menu and the dialogs in the Profile menu is that the Document Options' dialogs have a button "Apply To
Document" while the Profile's dialogs have an "Update Profile" or "Update Template" button (where
appropriate).
 
Please refer to the corresponding menu item in the Profile menu for further information.

8.8.2 Braille Format...

Command Key: None
Available: In the professional edition, when a source document is opened
 
 
The Braille Format will be displayed for the active document. Because of the complexity of all options, the
dialog box is built up with a category list on the left hand side to view the corresponding category controls
on the right hand side.  All settings contain options applicable for the whole document. The five pages in the
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dialog correspond to the Template dialog found in the Profile menu. The difference between the pages in the
Braille Format dialog and the pages in the Template dialog is that the Braille Format's dialog has a button
"Apply To Document" while the Template's dialog has an "Update Template" button. The Braille Format
dialog contains the following pages:
 
· Tables – How to convert tables in the document.
· Lists – How to treat bulleted and numbered lists in the document.
· Page number – Options for defining source page number in the Braille document.
· Reformatting – How to treat page breaks and empty lines in the Braille document.
· Styles  – A list box with all styles in the document's template.
 

 
 
Please refer to the Manage Templates… menu item in the Profile menu for further information.

8.8.3 Braille Style Format...

Command Key: None
Available: In the professional edition, when a source document is opened
 
The Braille Style Format options will be displayed for the active style. Because of the complexity of all
options, the dialog box is built up with a category list on the left hand side to view the corresponding
category controls on the right hand side. The active style is the style that is currently selected. If More than
one style is selected, WinBraille will display the settings for the style _DEFAULT. The four pages in the
dialog correspond to the Style sub dialog in the Template dialog found in the Profile menu. The difference
between the pages in the Braille Style Format dialog and the pages in the Template Style dialog is that the
Braille Style Format's dialog has a button "Apply To Document" while the Template's dialog has an "Update
Template" button. The Braille Style Format… menu item opens the same dialog as you open from the item
Document Options / Braille Format / Styles / [selected style] / Modify Braille Style. The Braille Style
Format dialog contains the following pages:
 
· Inheritance – Either select "Use own settings for this style", or select another style to inherit formats from.
· Paragraph – Format for paragraph alignment and indention, distance to previous and next paragraph, line

spacing, how to handle white space and tabular markers, whether attributes like bold, italic and underline,
shell be translated, and if adjacent lines shell be concatenated.
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· Translate – Translation rules and list of exceptions.
· Separator – Format of paragraph separator. A paragraph separator is a line of Braille cells that separates

the paragraph from the previous or next paragraph.
 

 
 
Please refer to the Manage Templates… menu item in the Profile menu for further information.

8.8.4 Change Profile...

Command Key: None
Available: Always when a source document is opened
 
Change profile for an active document. It is possible to change profile for an active document if more than
one profile exist in the system.
  

 

8.8.5 Shortcuts

Command Key: None
Available: In the professional edition, when a document is opened
 
The Shortcuts menu is a submenu with direct links (shortcuts) to the following pages in the Document
Properties, Braille Format, and Braille Style Format dialogs:
· Preferences 
· Embosser 
· Page Layout 
· Header 
· Graphics
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· Tables 
· Lists 
· Source Page number 
· Reformatting 
· Paragraph 
· Translate
· Hyphenation
· Separator 
 
All shortcuts are available for the source document. Only the Preferences, Embosser, and Header shortcuts
are available for the translated document.

8.9 The Braille Menu

8.9.1 Translate

Command Key: Ctrl + T
Available: When a source document is opened
 
The translate command translates the active source document to Braille according to the settings in the
current template. WinBraille displays a dialog box with information about the translation during the
translation. After the translation is finished, a new document will be displayed with the result of the
translation.

8.9.2 Exceptions...

Command Key: None
Available: When a source document is opened
 
The Exception dialog is an excellent way of building your own exception list. The exception list is a list of
words that should not be converted according to the active translation File. The list displays the word and its
alternative translation.
 

Scroll bars
This control has a tab stop, so it is possible to move to this control by using your TAB key. When this
control is active, you can scroll up or down using the up and down keys in order to examine the complete
exception list.
 

Exception
The dialog contains an exception control that displays the current selected word in your document. This field
will be empty if no word is selected. If you would like to add a new word, just delete the current word and
type a new word in the field.
 

Translation
Translation is the field for how you would like your word to be translated. The default translation is the
translation according to the active translation File.
 

Braille
The Braille control displays the translation into Braille. This filed cannot be changed. The Braille format is
according to the selected Braille table in the currently active translation file. The field displays an image of
the Braille cells, and can thus not be read with a Braille display.
 

Context
The context group of controls defines how the translation engine should treat the word during the translation.
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You can select either "Word" context or "Symbol or Syllable" context. In the "Word" context, translation is
performed according to the exception only if the translated symbol is a single word, separated with white
space or punctuation marks from other words in the sentence. In the "Symbol or Syllable" context,
translation is performed according to the exception even if the translated symbol is part of a word or a single
symbol.
 

Add
When pressing the Add button, the word and corresponding translation will be added to your list.
 

Remove
Delete the current word from the exception list.
 

OK
Close the dialog and accept all changes you have made to the exception list.
 

Cancel
Cancel all changes you have made to your exception list and close the dialog.
  

 

8.9.3 Sample Translation...

Command Key: None
Available: In the professional edition, when a source document is opened
 
The Sample Translation menu item opens a dialog box where you can type and translate any sentence in real
time. The translation is performed during the typing of the sentence.
 

 

The dialog has several fields and some radio button:
 

Unconverted Text
This field will be filled with the selected text if any. Type any word or sentence in order to examine the
translated result in the field "Converted Text".
 

Translated Text
This field will display the result of the translated text in Text mode.
 



100 WinBraille 4 User's Manual

Index Braille AB

Braille
This field will display the result of the translated text in Braille mode.
 

Edit Text
The "Edit Text" group box has two radio buttons. Select "Unconverted" if you want to type source text and
see the translation. Select "Converted" if you want to type translated text and see the result as Braille.

8.9.4 Character Table...

Command Key: None
Available: In the professional edition, when a source document is opened
 
The Character Table displays the character table in the currently active translation file.
 

 

8.10 The Profile Menu

8.10.1 Manage Profiles...

Command Key: None
Available: Always
 
This command opens the "Manage Profiles" dialog. The purpose with this dialog is maintenance of all
profiles in the WinBraille system. The dialog contains a list box with all profiles in the system, an array of
buttons, which operates on selected profile, and an information field, displaying the default profile. Note that
all changes in the profile will not affect documents that are already opened in the editor.
  

 
 

Select Profile
The "Select Profile" control contains all Profiles in the system. The Profile name is built up in two parts: The
Embosser name and a descriptive part of the profile to give the user a hint of the usage of the profile. The
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naming convention is important when several profiles exist in the system.
 

Set As Default
The "Set As Default" button will automatically set the selected profile to the default profile in the system.
This profile will be used when translating documents from other applications.
 

Edit
The Edit button opens a dialog box with all settings for the profile. For more information see Preferences.

Copy
The Copy button opens a dialog box for copying the selected profile. The Layout depends on if Professional
or Standard Edition is enabled.

Standard Edition
The dialog contains a field for entering the new profile's name. Type a new name and press OK to create
the new profile or press Cancel to close the dialog.  

Professional Edition
The dialog contains a field for entering the new profile's name and a check box "Create Template
automatically". When "Create Template automatically" is checked, WinBraille will automatically create a
Braille formatting template with the same name as the Profile. 

If the check box "Create Template automatically" is not checked, a group of controls are displayed for
manual creating or selecting of templates.
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Rename Profile
The Rename button opens a dialog box for renaming selected profile. The Layout depends on if
Professional or Standard Edition is enabled.

Standard Edition
The dialog contains a field for entering the new profile's name. Type a new name and press OK to rename
the profile or press Cancel to close the dialog.  

Professional Edition
The dialog contains a field for entering the profile's name and a check box "Rename Template if it is not
connected to any other profile". When the check box is checked, WinBraille will automatically rename the
template if it is not connected to any other profile. 

 

Delete Profile
The Delete button deletes the currently selected profile. A message box will appear if the user presses the
"Delete" button with an extra message about the deletion. This is done to minimize the risk of deleting the
wrong profile. A profile that is deleted cannot be restored. WinBraille will prevent the user from deleting all
profiles from the system. The Layout depends on if Professional or Standard Edition is enabled.
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Standard Edition
Select Yes to delete the profile or no to cancel the operation.

Professional Edition
 The dialog contains a field for entering the new profile's name and a check box "Delete Template if it is
not connected to any other profile". When the check box is checked, WinBraille will automatically delete
the Braille formatting template if it is not connected to any other profile.

  

8.10.1.1 Edit Profile

The Edit and the Copy buttons on the dialog "Manage Profile" will (after an additional step for Copy), open
a dialog box with all setting for the profile. Because of the complexity of all options, the dialog box is built
up with a category list on the left hand side and  the corresponding controls on the right hand side. The main
Dialog for the profiles contains the following pages:
 
· Preferences – Preferences for the WinBraille Editor.
· Embosser – Contains the name of the Embosser connected to the profile and some embosser specific

options.
· Page layout – Page size for the translated document (Braille Document) and margins.
· Header – Header and footer for the Braille document.
· Graphics - How to treat images.
· Format – The name of a template file containing all formatting options for translating a document to

Braille.
 
To navigate between the pages the user can use CTRL + TAB to move to the next page and CTR + SHIFT +
TAB to navigate to previous page.
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8.10.1.1.1  Preferences

The Preferences page displays all settings that affect the behavior of WinBraille. 

 

 
 

Maximize all windows
When maximize all windows is checked, all new source windows will be created as maximized windows.
The translated window is always maximized.
 

Automation
The group box "Automation" has three choices:
· Edit source document - When printing from another application, WinBraille will display the source text in

the source window without translating the text. 
· Edit translated document – When printing from another application, WinBraille will translate the source

text and only display the translated text in the translated window. It is not possible to edit the source text
because this window is not available.

·  Complete automation – When printing from another application, WinBraille will work in the background
and translate the text according to the default profile and send the text directly to the embosser.

 

Default mode when viewing a translated text
 This group box has two options for viewing the translated text:
· Show Print – The text is displayed with ordinary characters. This option should be used if the user has a
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Braille display or cannot read the Braille directly.
· Show Braille – This mode will display the translated text in Braille with dots on the screen. Note that the

characters are not mapped to the ANSI character set. This mode is not useful when using a Braille display.
 

Zoom factor for translated document
The zoom factor for viewing the translated document could be set with this list box.

Units
This control is used to present option units in either mm or inch.
 

Keyboard Mode
The keyboard mode group box has a check box called "Use 6 Key Entry". When this mode is activated, only
the keys f, d, s, j, k and l can be used to enter Braille characters. Every key corresponds to one dot position
in the Braille cell. To produce one Braille cell, the user must press one up to 6 of these keys at the same time
in order to get the correct Braille cell. This mode is independent of the viewing mode. Note that not all
keyboards on the market support the functionality to press several keys at the same time.
 
The definition of the position numbers in the dot cell is defined below together with corresponding keyboard
key.

  Key   Comment
  F   Dot 1, Upper left dot.
  D   Dot 2, Middle left dot.
  S   Dot 3, Lower left dot.
  J   Dot 4, Upper right dot.
  K   Dot 5, Middle right dot.
  L   Dot 6, Lower right dot.

8.10.1.1.2  Embosser

The Embosser page displays which embosser the Braille document will be sent to and some embosser
specific options.

Embosser Overview see. 
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Use Embosser
This read-only list box displays the embosser for the profile. It is not possible to change embosser for the
profile when working with the profile from the Manage Profile menu. To use another embosser go back to
Manage Profiles and create a new one. When a document is opened, it is possible to reselect another
embosser for that document.
 

Old Index Embosser
Old Index Embossers do not support all of the functionality that WinBraille can offer. When this check box
is activated, no extra information regarding page size and special printing options is transferred to the
Embosser. Therefore the user must set all these options directly from the front panel of the Embosser (or use
special software for sending this information to the embosser). The following Index Embossers are treated as
Old Embossers:
· Basic Old (blue bar)
· Everest-D (below 5.00)
· Everest (6.00 - 8.12)
· Basic D/S (below 3.20)
· 4X4 PRO (below 1.20)
For the above-mentioned Embossers, the check box "Old Index Embossers" must be checked.
The following older embossers are not supported:  Order a new embosser right from the web!
http://www.indexBraille.com
 
· Index 3.7 (84-85) - Not possible to upgrade
· Advanced (87-89) - Not possible to upgrade
· Classic (88-93) - Not possible to upgrade
· Domino (89-90) - Not possible to upgrade
 

Duplexing
The contents of the duplexing list box depends on the type of Embosser:
 
  Embosser   Contents in the list box
  Basic-S   Single sided
  Basic-D   Double Sided, Single Sided
  Everest   Double Sided, Single Sided

  4x4 Pro   Double Sided, Single Sided, 4 Side Stitch
 

Z-folding
The Z-folding option is only available for the for Basic-D embossers. In this mode, the pages are printed in
an order that minimize the work to stitch the pack of paper after the printout. The only thing you need to do
before you stitch is to rip off the strip of punched holes and separate each page at the perforation. There is
no need to rearrange the paper pack.

8.10.1.1.3  Page Layout

This Page contains three groups of controls for the Braille document: Margins, Page size and Orientation.

Page layout overview see.
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Top Margin
Top margin defines the number of empty lines before the main text. Note that top margin = 0 means that
there is no header available. To make room for the header line, enter a top margin of at least 1.
 

Bottom Margin
Bottom margin defines the number of empty lines after the main text down to the lower edge of the page.
Note that bottom margin = 0 means that there is no footer available. To make room for the footer line, enter
a bottom margin of at least 1.
 

Inner margin
The inner margin is the distance from the binding edge of the paper to the text.
 

Outer margin
The outer margin is the distance from the outer edge of the paper to the text.
 

Page size
The page size group box contains several controls for defining the correct Braille page size. The first control
in the TAB order is the list box "Page Size" with several predefined sizes. The last item in the list is
"Custom Paper", which will enable some extra controls for defining width and length of the page.
 

Width, Length and Units
Width and length of the paper size can be displayed either in tenth of millimetres or in thousands of inches.
These fields are only available if you have selected the custom paper size.
 

Orientation
The orientation option is not always enabled. Some papers are too large to be inserted in the landscape
orientation.
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8.10.1.1.4  Header

The Header page contains several groups of controls for defining the header and footer.

Header overview see.
  

 
 
The header and footer fields are grouped in two groups. One group defines the header and footer for "Odd
pages" and the other group defines the header and footer for "Even pages". Both groups of controls have
fields for left, center and right adjusted text. The two groups of controls are identical. It is possible to define
text in either of the left, center or right fields. Overwriting will occur if the size of the combined text is
greater than the maximum characters per line.
 

Begin Page numbering on Braille Page
This control defines the first page where header and footer are embossed.
 

Start Numbering With
This control defines the page number of the first page with an embossed header or footer.
 

Format Header and Footer according to Style
The header and footer text can be formatted according to style _DEFAULT or _HEADER. (The style
_HEADER is only available if it has been defined in the profile's template. This field cannot be changed if
_DEFAULT is the only available style).
 

Codes for page number, date and time
Several special codes are defined in order to create special text strings. All codes have the syntax %x, where
x is a special character defined below:
%b = Braille Page number
The %b is substituted with the current Braille page
%s = Source page number
The %s is substituted with the current source page number
%u = Source Sub Pages
The %u is substituted with current source sub page. When a source page is translated into several Braille
page, this code will produce a consecutive character, starting with "a" for every new Braille page that belong
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to a specific source page. If you enter "%s %u" and translate one source page into four Braille pages, the
pages will be numbered: 1 a, 1 b 1c and 1d.
 
%d = Date and Time Format
The %d is substituted with current date and time. The control "Date and Time…" defines the format.
 

Date and Time Format
%a
Abbreviated weekday name
%A
Full weekday name
%b
Abbreviated month name
%B
Full month name
%c
Date and time representation appropriate for locale
%d
Day of month as decimal number (01 - 31)
%H
Hour in 24-hour format (00 - 23)
%I
Hour in 12-hour format (01 - 12)
%j
Day of year as decimal number (001 - 366)
%m
Month as decimal number (01 - 12)
%M
Minute as decimal number (00 - 59)
 
%p
Current locale's A.M./P.M. indicator for 12-hour clock
%S
Second as decimal number (00 - 59)
%U
Week of year as decimal number, with Sunday as first day of week (00 - 53)
%w
Weekday as decimal number (0 - 6; Sunday is 0)
%W
Week of year as decimal number, with Monday as first day of week (00 - 53)
%x
Date representation for current locale
%X
Time representation for current locale
%y
Year without century, as decimal number (00 - 99)
 
%Y
Year with century, as decimal number
%z, %Z
Time-zone name or abbreviation; no characters if time zone is unknown
%%
Percent sign
#
The # flag may prefix any formatting code. In that case, the meaning of the format code is changed
as follows.
%#a, %#A, %#b, %#B, %#p, %#X, %#z, %#Z, %#%: # flag is ignored. 
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%#c: Long date and time representation, appropriate for current locale. For example: "Tuesday,
March 14, 1995, 12:41:29". 
%#x: Long date representation, appropriate to current locale. For example: "Tuesday, March 14,
1995". 
 
%#d, %#H, %#I, %#j, %#m, %#M, %#S, %#U, %#w, %#W, %#y, %#Y: Remove leading zeros (if
any). 

8.10.1.1.5  Graphics

The Graphics page contains a few controls for the usage of graphics:

Include Graphics in Translated document
Graphics can be included or excluded depending on this choice.

Automatically convert graphics while translating text
You should always convert manually the first time you include a new graphic image. Once you
have seen how the translation works you can check the automatic conversion.

Preferred Translated Image Size
There are three possible choices for the preferred image translation:
· Same size as the original
· Max half page height
· Page width
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8.10.1.1.6  Format

The Formatting template page contains a list box for connecting a template to the profile, and an edit button
for edit or modify the contents of the template file. This category is displayed only in Professional Edition.
 

 
 
The format page is where you tell WinBraille which Template you want to use as a template for the Braille
translation when you use this Profile, as well as when a new document is created using this Profile.
 

Template
Select one of the available Templates from the drop-down menu. Templates are installed during the Index
Custom Installation. You can also create your own templates by saving a document as a Template.
 

Edit Format
The selected Template's Braille formats can be edited directly from the Profile. Note that this will change the
settings in the Template, and not in the Profile. The Template file can be referenced from more than one
Profile. If you change such a template, all Profiles that reference this template will create documents with the
same Braille layout.
See Manage Templates  for details.

8.10.2 Shortcuts

Command Key: None
Available: Always
 
The Shortcuts menu is a submenu with direct links (shortcuts) to the following pages in the Manage Profiles
and Manage Templates dialogs:
Preferences 
Embosser 
Page Layout 
Header 
Graphics
Tables 
Lists 
Source Page number 



112 WinBraille 4 User's Manual

Index Braille AB

Reformatting 
Paragraph (Only in Professional Edition) 
Translate 
Hyphenation (Only in Professional Edition)
Separator (Only in Professional Edition) 

8.10.3 Manage Templates...

Command Key: None
Available: In the professional edition
 
This command opens the "Manage Templates" dialog. The purpose with this dialog is to maintain all
templates in the WinBraille system. The dialog contains a list box with all templates in the system, an array
of buttons that operates on the selected template and an information field displaying the profiles where the
template is used.
 
Normally you should not delete a template that is linked to a profile. If a template is linked to a profile,
delete that profile or reselect another template for that profile before you delete the template.
 

 
 

Edit
The Edit button opens a tabbed dialog box with the Braille format for the template.
 

Copy
The "Copy" button opens a dialog box for copying the selected template. The dialog contains a field for
entering the new template's name. Type a new name and press OK to create the new template, or press
Cancel to close the dialog.
 

 
 

Rename
The "Rename" button opens a dialog box for renaming the selected template. The dialog contains a field for
entering the template's new name. Type a new name and press OK to rename the currently selected template,
or press Cancel to close the dialog.
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Delete
The "Delete" button deletes the currently selected template. A message box will appear if the user presses
the "Delete" button, with an extra message about the deletion. This is done to minimize the risk of deleting
the wrong template. A template that is deleted can not be restored. WinBraille will prevent the user from
deleting all templates from the system.

8.10.3.1 Edit Format

When pressing the "Edit Format" button on the page "Format" a tabbed dialog box will be displayed with all
setting for the selected template. Because of the complexity of all options, the dialog box is built up with a
category list on the left hand side and  the corresponding controls on the right hand side.  All the setting in
the first tabbed dialog contains options applicable for the whole document. The main Dialog for the template
contains the following pages:
· Tables – How to convert tables in the document.
· Lists – How to treat bulleted and numbered lists in the document.
· Source Page number – Options for defining source page number in the Braille document.
· Reformatting – How to treat page breaks and empty lines in the Braille document.
· Styles  – A list box with all styles in the template.

8.10.3.1.1  Tables

Table Overview

The Tables page defines how to format tables in the document. Select one of three methods:
 
· Wrap Columns – Each column on a row will be wrapped down to a new line and indented by a number of

characters. The indentation is given by the control "Indent each column".
· Delimiter, Row by Row - The table will have the same layout as the original table, except that a delimiter

symbol separates each cell. The delimiter symbol is given by the control "Delimiter Character". The
control "Delimiter Character" is the next control in the TAB order.

· Delimiter, Column by Column - The table is "rotated" 90 degrees. This means that the first column will be
the first row, the second column will be the second row and so on. A delimiter symbol will separate each
cell. The delimiter symbol is given by the control "Delimiter Character".
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Indent each column
Each column on a row will be wrapped down to a new line and indented by a number of characters. The
indentation is given by this control.
 

Minimum Column width
WinBraille will try to decrease the column width until it will fit on the page. If the width for all columns
reaches the minimum width, WinBraille will split the column into several parts.
 

Delimiter Character
Choose a delimiter character to separate each cell in the table.
 

Braille Symbol 
This field displays the delimiter character as a Braille symbol.
 

Character in the Source Document
This field displays as information the equivalent delimiter character as it would be entered in the source
document. (The character given in the "Delimiter Character" filed is the character in the translated document
as it is embossed on the embosser).
 

Format Tables according to Style
This list box is used to select the Style of the text in the table.

8.10.3.1.2  Lists

The List page contains options for converting bulleted lists. 
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Exchange Bullet character with
The First control is "Exchange Bullet character with". This list box contains all possible characters available
for substituting the bullet character.
 

Indent Bullet character with
The distance between the left margin and the bullet character is defined with this control.
 

Space between the Bullet character and paragraph
This control defines the distance between the bullet character and the paragraph. The next control is called
"Example" and will display an example of how WinBraille will convert a bulleted paragraph using the
defined settings.

8.10.3.1.3  Source Page number

The Page number selection will produce a text line in the Braille document, indicating where every source
page ends. This function can be combined with header information, which gives total control of the relation
between a Braille page and a source page.
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8.10.3.1.4  Reformatting

The Reformatting page contains 2 groups of controls. The first group of controls handles how to treat page
breaks and the other group how to treat empty line.
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Page Breaks
This group of controls handles how to treat page breaks.
 
· Keep empty pages and page breaks – All empty pages and manually inserted page breaks are maintained.
· Remove empty pages – Empty pages are removed, but manually inserted page breaks are not removed.
· Remove empty pages and page breaks – All empty pages and manually inserted page breaks are removed.
· Remove empty pages and page breaks, except for page breaks defined in "Paragraph" settings. - In

Professional Edition, page breaks could be set for a style. This option will remove page breaks and empty
pages for all styles where the option "Insert page break before paragraph" is not set.

 

Empty Lines
The two first controls in this group handle how to treat empty lines. The first "Keep empty lines" will keep
the original formatting and leave all empty lines.
 
The option "Format empty lines according to this table:" will enable an array of controls for defining an
algorithm for handling empty lines. The array is built up with 5 rows. Each row of controls forms a Rule on
how to treat empty lines.
The two first controls on the row are "Line to convert" and "or more". They define together how many
empty lines the rule will be applied to. 
The third control defines how many lines this rule should be converted to. A "0" means that the line(s)
should be removed. The fourth control defines how many characters the next line should be indented.
 
When all controls are filled with data the algorithm might look like this:
Line to convert = 1, Or more = Not marked, Translates to = 0, Indent next line = 0.
Line to convert = 2, Or more = Not marked, Translates to = 1, Indent next line = 0.
Line to convert = 3, Or more = Marked, Translates to = 1, Indent next line = 1.
In plain text the rules are:
1 empty line should be removed.
2 empty lines should be converted to 1 empty line.
3 empty lines or more should be converted to 1 empty line and the first line of text after the empty lines
should be indented 1 character.
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Spaces
The Space group has three possible options: "Keep original spaces", "Exchange multiple spaces with single
space" and "Treat spaces according to "Paragraph" settings". When "Exchange multiple spaces with single
space" is selected, an extra check box for leaving the indents is enabled. The "Treat spaces according to
"Paragraph" settings" is only enabled for Professional Edition. If this option is selected the settings for each
style will be used during the translation.

Concatenate adjacent paragraphs
The group concatenate adjacent paragraphs removes CR LF between two consecutive paragraphs. the tree
available options are:
· Newer - Even if this function has been set for several styles, this option will override that behaviour.
· Always - Even if this function has been set for several styles, this option will override that behaviour.
· Concatenate adjacent paragraphs according to paragraph settings. Only consecutive paragraphs of the

same style will be concatenated. see example below

8.10.3.1.5  Styles

The Styles Page contains a list box with all styles in the template and a button "Modify Braille Style".
  

 
 

Braille Styles
This list box contains all available Braille styles in the template. Three predefined styles are always available
in the template.
· _DEFAULT – this is the default style for styles not defined in the template.
· _TABLE – This style should be used to format all text in all tables in the document.
· _DOCPGNO – This style should be used to set the format for Source Page Number in the Braille

document.
A fourth style, _HEADER, can be created for formatting text in the header and the footer. The text in the
header and the footer will be formatted according to the _DEFAULT style if _HEADER is not available.
 

Modify Braille Style
The button "Modify Braille Style" opens a tabbed dialog box with all options for each Braille style.



119WinBraille Menu Reference

Index Braille AB

8.10.3.1.5.1  Inheritance

The tabbed dialog box for displaying all options possible to set for a Braille Style displays always the
"Inheritance" page first. This page has two radio buttons. You can select whether the style should have its
own settings or if it should inherit the settings from another style. If "Inherit from style" is enabled, a list box
with all styles in the template that have own settings is displayed. In this case all other pages are disabled
and it is not possible to move to these pages. To enable the pages the user must chose "Use own settings for
this style". This category is displayed only in Professional Edition.
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8.10.3.1.5.2  Paragraph

The Paragraph page contains eight groups of controls.  These eight groups form together the main format of
the paragraph.
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Space
The Space group has two possible options: "Keep original spaces" or "Exchange multiple spaces with single
space". When "Exchange multiple spaces with single space" is selected, an extra check box for leaving the
indents is enabled.
 

Tabs
The Tab group contains of a control for substituting the tabulator symbol to one or more spaces.
 

Distances
The "Distances" group contains two controls for defining the number of empty lines above and below the
paragraph. The two controls are "Top" and "Bottom". All values are measured in lines. When converting
two consecutive paragraphs, the distance between the two paragraphs is calculated by taking the maximum
value of the bottom distance for the previous paragraph and the top distance for the next paragraph.
 

Indents
It is possible to set the indents on the left and right side of the paragraph. The first line in the paragraph can
have a special indent called "First Line". An extra check box called "As In Document" will convert the
indents in the source document from millimetres to multiples of the Braille character width.
 

Attributes
The attributes "Bold", "Italic" and "Underline" can be converted to special prefixes and suffixes around
words that have any of these attributes. The "Attributes" controls are only enabled if rules for handling these
attributes are defined in the translation file.
 

Line Spacing
The line spacing value is measured in multiples of the height of the Braille cell (in units of whole lines).
 

Alignment
There are four options for setting the alignment of the paragraph:
 
· Left – Left adjust the paragraph.
· Center – Center the paragraph.
· Right – Right adjust the paragraph.
· As in Document – Adjust the paragraph as it is in the source document.
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Concatenate adjacent lines
This option will remove all line feeds during the translation. This option will "compress" the Braille output.

Insert page breaks before paragraphs 
This item will insert a page break before the paragraph which will guarantee that the first paragraph will start
on a new page.

8.10.3.1.5.3  Translate

The "Translation" page is one of the core pages in the system. The Page contains two groups of controls, the
Translation and the Exception groups.
 

 

Translation
This group of controls has a list box with all installed rule files in the system. Directly when the user selects
a translation file, the "Details" field will be updated with information regarding the selected translation file.
 

Properties
The "Properties" button is a button that opens a dialog box with properties for the selected translation file.
This button is only enabled for rule files that have this feature. Properties vary depending on what features
can be changed in the rules. The example below shows the properties for a Bulgarian translation file.
  

 
 

Exception File
The exception file is a file that contains a list with all words, phrases, and symbols that should not be
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translated according to the selected translation file. 
 

Options
Use the "Options" button to open a dialog box with five selections: New, Copy, Delete, Clear and Edit
Exception List.

The button is only available for those exceptions list that has such a support. See Manage exceptions for
details on how to handle the exception lists.

8.10.3.1.5.4  Hyphenation

The Hyphenation page has four options available:
· No Hyphenation - Words that doe not fit on the line will be wrapped down to the next line.
· Right aligned - Splitting words so that the hyphen always will be located on the right most position.
· Wrap word less than - Like Right aligned except that it is possible to wrap word with a certain word

length.
· Hyphenation according to translation file - A special translation file with the extension ".ibh" will take

care of the hyphenation.



124 WinBraille 4 User's Manual

Index Braille AB

8.10.3.1.5.5  Separator

The "Separator" page contains two check boxes for defining a separator line above and below the paragraph.

 

 
 
The two check boxes are "Top" and "Bottom".  When the Top check box is enabled, a set of six controls is
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enabled for defining the separator line. There are two identical sets for both the "Top" and "Bottom" check
box.
 

Top
When the "Top" check box is checked, seven more controls are enabled. The next control in the TAB order
is a field where the user can define a text for the separator line. The next four controls are radio buttons for
defining the position and appearance of the text. The buttons are:
 
· Left – Left adjust the text
· Center – Center the text
· Right – Right adjust the text
· Fill – Fill the whole line with a multiple of the text
 

Place Separator Line
The "Place Separator Line" is a spin box control for placing the text a distance above the paragraph. The
unit is in Lines.
 

Inhibit separator for empty lines
Sometimes you enter an empty line after a paragraph with a separator. Then you can mark this control so you
don't need to mark all those empty lines with a style that does not contain a separator line.
 

Bottom
When the "Bottom" check box is checked, seven more controls are enabled. The next control in the TAB
order is a field where the user can define a text for the separator line. The next four controls are radio
buttons for defining the position and appearance of the text. The buttons are:
 
· Left – Left adjust the text
· Center – Center the text
· Right – Right adjust the text
· Fill – Fill the whole line with a multiple of the text
 

Place Separator Line
The "Place Separator Line" is a spin box control for placing the text a distance below the paragraph. The
unit is in Lines.
 

Inhibit separator for empty lines
Sometimes you enter an empty line after a paragraph with a separator. Then you can mark this control so you
don't need to mark all those empty lines with a style that does not contain a separator line.

8.10.4 Manage Rule Files...

Command Key: None
Available: Always
 
The command "Manage Rule Files…" opens a dialog for adding and removing rule files in WinBraille.
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The dialog contains four groups of controls and three "multifunction" buttons for managing the rule files.
The groups are called "Get Rule File From", "Installed Rule Files", "Available Rule Files" and "Rule File
Information". The "multifunction" buttons change title and function depending on the situation.
· When "Get Rule Files From Local" is selected the buttons are: "Browse", "Install" and "Delete".
· When "Get Rule Files From Internet" is selected the buttons are: "Connect", "Install" and "Delete".
· When "Get Rule Files From Deleted" is selected the buttons are: "Restore" and "Delete".
 

Group box "Get Rule Files From"
WinBraille offers three different ways of getting the rule files into WinBraille: From a local hard drive or
network, from Internet, or from WinBraille's built-in "Rule File Recycle Bin". 
 
The first group of controls is called "Get Rule Files From". The group contains three radio buttons for
selecting the location of the translation file source.
 

Local
The "Local" radio button enables the user to browse for a folder where the rule files are located. When this
radio button is checked, the next button in the TAB order is the "Browse" button.
 
The option "Local" is normally used to get rule files from the Index CD. A directory on the CD contains all
available rule files. Insert the CD into the CD drive before pressing the "Browse" button if you are going to
copy rule files from the CD.
When the CD is inserted and the user presses the "Browse" button, WinBraille will scan the CD in order to
search for rule files. If WinBraille detects a directory with rule files, the "Browse" dialog will be displayed
with the translation file directory already selected. The OK button on the Browse dialog will in this case be
enabled. WinBraille enables the OK button only if there exist rule files in the selected directory.
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After selecting OK in the "Browse" dialog, WinBraille will sort available rule files by language and display
these files in a tree in the "Available Rule Files" window.
 

 
 
The (+) key on the numeric keyboard will expand the selected language in the "Available Rule Files"
window to make all rule files for that language visible. Every language can also be expanded for displaying
important information about the translation file.
When the translation file is selected, the "Install" button will be enabled. This will also be the next control in
the TAB order.
 

Internet
This radio button enables the user to get rule files from Index home page. This option is recommended if an
Internet connection exists because Index home page is always updated with the latest rule files.
 
When this radio button is checked, the next button in the TAB order is the "Connect" button.
When the "Connect" button is pressed, an information message is displayed that a connection is going to be
established to Internet in order to get all available rule files from Index home page.
WinBraille will download a list with all rule files and display these in the "Available Rule Files from
Internet" control. 
The (+) key on the numeric keyboard will expand the selected language in the "Available Rule Files From
Internet" window to make all rule files for that language visible. Every language can also be expanded for
displaying important information about the translation file.
 
When the translation file is selected, the "Install" button will be enabled. This will also be the next control in
the TAB order.
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Deleted
This radio button enables the user to restore rule files from WinBraille's built-in "Rule File Recycle Bin".
 

Available Rule Files From Rule File Recycle Bin
The next control in the TAB order is "Available Rule Files From Rule File Recycle Bin". This field contains
all deleted rule files. 
 

Installed Rule Files
The "Installed Rule Files" control displays all installed rule files in WinBraille. When selecting a translation
file, the "Rule File Information" control will display information about the selected translation file. The
"Rule File Information" control is the next control in the TAB order.

Delete a rule file
To delete an installed translation file, the user must use the TAB key from the "Installed Rule File" to "Rule
File Information" in order to read what kind of translation file it is, and after that TAB to the "Delete"
button. Deleted rule files are stored in the "Rulefile Recycle Bin". These rule files are possible to restore
after an accidental deletion.
 

 

8.10.5 Manage Exceptions

Command Key: None
Available: In the professional edition
 
This menu item pop-ups a list of menus: New Exception List, Copy Exception List, Delete Exception List,
Clear Exception List, and Edit Exception List.
 

New Exception List
The Menu "New Exception List" opens a dialog that has six edit fields, one list box and two buttons.
· List Name - The list name is the unique name that identifies the list.
· Character Set - The list box contains all character sets that are possible to use for the list.
· Description – A description of the content of the list.
· Language - Language for the list.
· Author - The name of the author.
· Version - Version of the list.
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· Date - Current date.
  

 
 

Copy Exception List
The Dialog "Copy Exception List" is almost identical to the dialog "New Exception List" except for the List
Box "Copy From".
· New List - The name of the copy.
· Copy From - The name of the original list.
· Description – A description of the content of the list.
· Language - Language for the list.
· Author - The name of the author.
· Version - Version of the list.
· Date - Current date.
  

 
 

Delete Exception List
This dialog is used to delete an exception list permanently from the system. A deleted exception list can not
be restored.
 

 
 

Clear Exception List
This dialog is used to completely remove the contents of an exception list.
 

 
 

Edit Exception List
The Menu "Edit Exception List" opens a dialog that has two list boxes and two buttons.
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Exception List - The name of the list that is going to be edited.
Rule File – Select a translation file to get proper character coding. The exception list does not contain any
information about the character coding. Every exception list is used together with a translation file. To be
able to edit the content in the exception list properly, you must supply the correct translation file. (For
example, use a Greek translation file to get Greek letters if you are going to edit an exception list with Greek
words, and use a Russian translation file to get Russian letters if you are going to edit an exception list with
Russian words).
 

 

8.11 The Window Menu

8.11.1 Tile Horizontal

Command Key: None
Available: When a document is opened
 
Tiles MDI child windows so that one window appears above another.

8.11.2 Tile Vertical

Command Key: None
Available: When a document is opened
 
Tiles MDI child windows so that one window appears beside another.

8.11.3 Cascade

Command Key: None
Available: When a document is opened
 
Cascades MDI child windows. 

8.11.4 Arrange Icons

Command Key: None
Available: When a document is opened
 
Place minimized documents, cluttered in the WinBraille client area, at the bottom left corner. 

8.12 The Internet Menu

8.12.1 Index Home Page

Command Key: None
Available: Always
 
This menu item opens the Index home page if the computer is connected to the Internet.



131WinBraille Menu Reference

Index Braille AB

 

8.12.2 Check for Upgrades

Command Key: None
Available: When no documents are opened
 
This menu item will check Index site for upgrades if the computer is connected to the Internet. The
following message will be displayed if you have the latest version of WinBraille:
 
If a newer version exists, you will be prompted to download the new version. Information about the upgrade
is shown in a dialog. You can also see how large the upgrade is, so you can decide whether your Internet
connection is fast enough to download the upgrade in a reasonable time. WinBraille will close, upgrade, and
restart if you press the Yes button.

8.12.3 Software Performance Report

Command Key: None
Available: Always
 
This menu item creates a Feedback Form with information about your computer, embosser and WinBraille.
You can send this form directly to Index Braille if you have an Internet connection.

8.13 The Tools Menu

8.13.1 Emboss Test page

Command Key: None
Available: Always
 
The Print Test page dialog is invoked during the installation of WinBraille. The feature is useful for
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verifying that the embosser and WinBraille have been installed correctly. The menu is always available in
the Tools menu. The Page that will be printed contains no Braille information. Only a pattern of dots will be
printed.
 

 

8.13.2 Edit Rule File...

Command Key: None
Available: In the professional edition
 
Opens the program Index Rule File Editor. Use the program to create or modify rule files. See the Tools
chapter for more information.
 

 

8.13.3 Image Editor...

Command Key: None
Available: Always

Opens the program Image Editor. See the Tools chapter for more information.
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8.13.4 Index Add Printer Wizard...

Command Key: None
Available: In the professional edition when no documents are opened
 
Opens the Index Add Printer Wizard. Use the wizard to install more embossers. The wizard is also a part of
the installation of WinBraille. See the Tools chapter for more information.
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8.13.5 Index Setup...

Command Key: None
Available: In the professional edition when no documents are opened
 
Opens the Index Setup program. Use the program to install or create an Index Custom Package. The
program is also a part of the installation of WinBraille. See the Tools chapter for more information.
 

 
 

8.13.6 Language...

Command Key: None
Available: In the professional edition when no documents are opened
 
Opens the WinBraille Language Setup Tool. Use the tool to change language of menus, dialog and
messages. See the Tools chapter for more information.
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8.13.7 Macro

The macro functions can be used to record and play mouse and keyboard events.
The following functions are available to manage macros:
 

· Record
· Stop
· Play
· Open
· Save 

8.13.7.1 Record

Command Key: F7
Available: In the professional edition when a document is opened
 
Press the F7 key to start recording mouse and keyboard events.
 

8.13.7.2 Stop

Command Key: Ctrl + Break
Available: In the professional edition when a macro is playing

Press the CTRL and BREAK keys to stop recording mouse and keyboard events.

8.13.7.3 Play

Command Key: F8
Available: In the professional edition when a macro is opened or has been
recorded
 
Press F8 to play the recorded mouse and keyboard events.

8.13.7.4 Open

Command Key: None
Available: In the professional edition
 
The Open menu item opens a macro function with recorded mouse and keyboard events.

8.13.7.5 Save

Command Key: None
Available: In the professional edition when a macro has been recorded
 
The Save menu item saves mouse and keyboard events to a macro function.



136 WinBraille 4 User's Manual

Index Braille AB

8.13.8 Application Components

Command Key: None
Available: In the professional edition
 

Install..
Install the Office and/or Adobe Acrobat Macros.

Uninstall..
Uninstall the Office and/or Adobe Acrobat Macros.

8.14 The Help Menu

8.14.1 Help Topics

Select Help Topics to open up the WinBraille help:

Use the Content menu, the index or the search feature to find the help you require.

8.14.2 About WinBraille...

Select About WinBraille to receive detailed information about the WinBraille version. This may be
requested when you talk with Index Support.
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8.15 Key mapping

8.15.1 Function Keys

  F1   Opens the WinBraille Help File at the Contents topic
  F7   Record Macro
  F8   Play Macro
  ALT + F4   Close WinBraille.

8.15.2 Movement Keys

 
  DEL   Deletes selected text.
  END   Moves the caret to the end of the line.
  HOME   Moves the caret to the beginning of the line.
  PAGEUP Scrolls the height of the current client area upwards and moves the caret to the
same screen position.
  PAGEDOWN Scrolls the height of the current client area downwards and moves the caret to the
same screen position
  (Left Arrow) Moves the caret one character to the left.
  (Right Arrow) Moves the caret one character to the right.
  (Up Arrow) Moves the caret one line up.
  (Down Arrow) Moves the caret one line down.
  CTRL+(Left Arrow) Moves the caret to the beginning of the current word.
  CTRL+(Right Arrow) Move the caret to the beginning of the next word.
  CTRL+HOME Move the caret to start of text.
  CTRL+END Moves the caret to end of text.

8.15.3 Control Keys

  CTRL + A   Select all text.
  CTRL + B Emboss the document.
  CTRL + C Copies selected text to the clipboard.
  CTRL + D Opens the font dialog for changing the font of the selected text.
  CTRL + E Center the text.
  CTRL + F Open the built-in "Find" dialog for searching for text in the document.
  CTRL + G Executes the Edit Goto Page command to move the caret to a specific page
  CTRL + H Open the built-in "Search and replace" dialog for searching and replacing text 

in the document.
  CTRL + I Open the dialog "Manage Profile".
  CTRL + L Left adjust the text.
  CTRL + N Executes the File New command to create a new, empty edit window
  CTRL + O Executes the File Open command to open an existing file
  CTRL + P Executes the File Print command to print the file showing in the current window
  CTRL + Q Quit the program.
  CTRL + R Right adjust the text.
  CTRL + S Executes the File Save command to save the current file to disk
  CTRL + T Executes the Translate command to translate the source text into Braille.
  CTRL + V Inserts text from the clipboard.
  CTRL + F2 Insert translated text at current input position.
  CTRL + W translate the text in the clipboard and paste it in at current input position.
  CTRL + X Copies selected text to the clipboard and deletes the selection.
  CTRL + Y Redo the last operation.
  CTRL + Z Undo the last operation.
  CTRL+ENTER Inserts a new page.
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  CTRL+(-) Inserts an end-of-line hyphen.
  CTRL+INS Copies selected text to the clipboard.
  CTRL+(Backspace) Deletes the previous word.
  SHIFT+ENTER Creates a line feed.
  SHIFT+DEL Copies selected text to the clipboard and deletes the selection.
  SHIFT+INS Inserts text from the clipboard.
  CTRL+SHIFT+(Space) Insert a non-breaking space.
  CTRL + F4 Close the active document.
  CTRL + TAB Switch between pages in a property sheet.
  CTRL + F6 Activate next document.
  CTRL + BREAK Stop Macro recording.
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9 Translation File Reference

9.1 Introduction

 The goal with the WinBraille system is to make a seamless printing process of Braille documents from a
word processor or other application to the Index Braille Embosser. This usually involves text translation to
suit the specific needs in producing Braille. Since different translation rules apply for different languages
and different grades of contractions, the WinBraille system provides the tools to manage and edit contraction
rule files.
The structure of the rule files is adapted to suit editing of text in foreign languages as well as using a Braille
display to read and edit the rule files. Features are:
· Foreign language support.
· Defining displayed characters to suit reading text appeared on the screen with a Braille display with any

kind of Text to Braille character coding.
· Plain text formats. No graphical user interface or strange file formats.

The rules are defined in a source file in plain text format. This file usually has the prefix ".txt", since it is a
plain text file. To speed up the text conversion process, WinBraille uses a binary format of the rules. This
binary format is created with a built-in compiler in the WinBraille Rule File Editor. The resulting binary file
has the prefix ".ibk". The text file is embedded within the binary file and is automatically extracted when the
binary file is opened in the WinBraille Rule File Editor. Thus there is no need to keep the source file after
compilation.

9.2 WinBraille Contraction Rules

The contraction rules are defined in a script language, SLIB (Script Language for Index Braille). The
language does not contain any predefined symbols that can be used in the creation of the rules. All symbols
must therefore be defined in prior to usage, thus the first part of the file contains symbol definitions. These
definitions include for example a header, definitions of STARTOFPARAGRAPH and NEWLINE, number
prefix and capital prefix, both single capital prefix and multi-capital prefix. Other types of prefixes can be
defined as well, as for example an escape prefix to resolve ambiguities. Other definitions are the lists of
symbols used in the rules, as for example the list of capitals, the list of figures, the punctuation marks used,
and eventually the letters that correspond to the figures in Braille.

The list rule definition defines how the contraction rules shall treat the symbols in the list. Example: To
determine if a multi-capital prefix has to be inserted, define a list rule that searches for two letters from the
list of capitals.

The second part of the file contains the rules. These can further be divided into inserting rules and replacing
rules. This part also contains a Braille table and eventually a table for duplicate characters. Duplicate
characters are characters that use a Braille symbol already occupied by another character according to the
Braille table. The duplicate character table was necessary in WinBraille 2.xx, but is obsolete in WinBraille
3.xx and 4.xx, since all duplicate characters can be defined directly in the rules.

9.3 Conventions
 

All text in the SLIB language is defined between quotation marks, example: "a", "X", "?", "copyright".
A Braille symbol is defined with the lower case letter p and a list of dots, example: The Braille symbol for
the letter "a" is p1. A full cell is typed as p123456. A space, i.e. an empty cell, is thus defined as p. No space
is allowed after the p and before the dot numbers. At least one space must be inserted between two Braille
symbols, example: The text string "abc" is typed as the Braille symbols p1 p12 p14. 
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The dots in a Braille cell are numbered:
1 4
2 5
3 6

 

Since the quotation mark " is used to delimit text, the quotation mark itself must be proceeded with the
escape character "\" to be recognized as a quotation mark. Example: The text string #"K is typed as "#\"K".
Since the backslash character "\" is used as an escape character, the backslash itself must be typed twice to
be recognized as a backslash character. Example: The string #\K is typed as "#\\K".
Any ASCII character can be defined with its decimal or hexadecimal value with "\dnnn" or "\hxx",
respectively, where nnn is the decimal value and xx is the hexadecimal value.
 
The "<" symbol marks the start of a contraction rule, and the ">" symbol marks the end of a rule.
Some predefined identifiers can not be used as user defined symbols. These are: attribute, braille,
brailletable, charset, default, define, depend, equivalence, extern, include, interface, list, listrule, param,
password, state, gstate, lstate, istate, and the obsolete identifier ascii. Since the small letter p is used to define
Braille symbols, no user-defined symbol can start with the small letter p followed by a number.
 
A hyphen ("-") in the first column marks a comment. A definition can be extended to the next line by
inserting a "+"-sign in the first column, example:
 

list lowerletter_a_to_j_list = ["a", "b", "c", "d", "e",
+                               "f", "g", "h", "i", "j"]

9.4 Translation File (Rule File) Structure

9.4.1 Sections

 The translation file (rule file) can contain the following sections, in specified order:
· Header
· Includes
· Definitions
· Rules

9.4.2 The Header Section

The very first lines in the translation file should be a header with information about the file content. The
header is read by WinBraille and the information is used to inform the user about the translation file content
and to categorize the rules in language groups to ease the rule management. The header must start at the first
position in the first line of the file, and the first two characters must be the characters "-=", for WinBraille to
be able to recognize the header information. The header should have the following format:

 

-=========================================
-Description: A description of the type of rules in the file
-Language: The language the rules are meant to be used for (ex: English)
-Author: The author of the file content
-Version: Version number (ex: 1.0)
-Date: Last editing date (ex: 2000-09-12)
-=========================================

 
The language tag is mandatory for WinBraille to be able to classify the rules in a language group. The
description, author and date tags are highly recommended. Other tags are optional. User tags are allowed, as
for example an information tag (-Info) for extra information.
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9.4.3 Variables

Up to nine variables can be defined and used in the rules. The variables are typed as @1 to @9. They are local
to each translation file, but their values will be maintained from one translation to the next, as long as the
translation is performed with the same translation file. Examples are given in the sections "The Interface
Definitions" and "The Contraction Rules: ...".

9.4.4 Includes

 Files can be nested with an include statement, example:
 

include definitions.txt
 

 

The files can be nested in an unlimited number of levels, and they can contain an unlimited number of
include statements. The include statement can be placed anywhere in the file, as long as it is alone on a
single line.

9.4.5 The Definitions Section
 

The definitions section contains the following sub-sections:
· Predefined definitions
· Symbol definitions
· Character set definition
· Password definition
· Default character definition
· Attribute definitions
· State definitions
· Interface definitions
· Parameter definition
· External function definition
· Dependent file definition
· List definitions
· List rule definitions
· Character equivalence definitions
 
There is no specific restriction in the order of the definitions, except that all used identifiers must have been
defined before they can be used. That implies that lists must be defined before the equivalence definitions
and the list rule definitions, states must be defined before the interface definitions, the parameter definition,
and the external function definition, and the predefined definitions should come first, since these definitions
are used in many of the other definition statements.

9.4.6 The Define Statement
 

The predefined identifier define can be used to define common used symbol strings. Example:
 

define one = "one"
define space = " "
define symbol = firstcharacter, restcharacters
define numberprefix = p3456
define copyright = p14 p135 p1234 p13456 p1235 p24 p1245 p125 p2345
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9.4.7 The Predefined Definitions
 

Some predefined strings and Braille constants are used by the WinBraille Contraction Rule Engine for
start-of-line, end-of-line, and other text features. Alias definitions for these constants can be used in the
translation file to make the rule definitions more readable. The recommended aliases and their corresponding
strings and Braille constants can be included in the translation file with these lines of code:

- Text and Paragraph Markers
define STARTOFPARAGRAPH    = "\d027\d001"
define ENDOFPARAGRAPH      = "\d027\d002"
define ENDOFTEXT           = "\d027\d003"

- Escapes for Empty Lines
define EMPTYLINE0          = "\d027\d016"
define EMPTYLINE1          = "\d027\d017"
define EMPTYLINE2          = "\d027\d018"
define EMPTYLINE3          = "\d027\d019"

- Text Attribute Prefix and Postfix
define BOLD_ON             = "\d027\d064"
define BOLD_OFF            = "\d027\d065"
define ITALIC_ON           = "\d027\d066"
define ITALIC_OFF          = "\d027\d067"
define UNDERLINE_ON        = "\d027\d068"
define UNDERLINE_OFF       = "\d027\d069"

- Non-Printable Characters
define TAB                 = "\d009"
define NEWLINE             = "\d010"
define NEWPAGE             = "\d012"

- Braille Escapes
define BRL_NEWLINE         = p7 p17
define BRL_NEWPAGE         = p7 p27
define BRL_p7              = p7 p7

- Default Values
define ORIGINAL_TEXT       = "\d027"
define EMPTY               = ""
define FULL_CELL           = p123456
define SPACE               = " "

- Dependent Files Update Flag
define UPDATE              = 1

- Text Attribute Flags
define BOLD                = 1
define ITALIC              = 2
define UNDERLINE           = 4

- Translation
define TRANSLATION         = 769
define TRANSLATION_ON      = 768
define TRANSLATION_OFF     = 769

- Source
define SOURCE              = 770
define SOURCE_PRINT        = 768
define SOURCE_BRAILLE      = 770

- Braille Tables
define BRAILLETABLE        = 792
define CUSTOMBRAILLE       = 768
define MITBRAILLE          = 776
define EUROBRAILLE         = 784
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- Character Sets
define ANSI_CHARSET        = 0
define GREEK_CHARSET       = 161
define CHINESEBIG5_CHARSET = 136
define TURKISH_CHARSET     = 162
define ARABIC_CHARSET      = 178
define BALTIC_CHARSET      = 186
define RUSSIAN_CHARSET     = 204
define HEBREW_CHARSET      = 177
define THAI_CHARSET        = 222
define EE_CHARSET          = 238

 

The constants STARTOFPARAGRAPH, ENDOFPARAGRAPH and ENDOFTEXT can be used to
recognize the start and the end of the paragraph and the end of the text to be translated. 

EMPTYLINE0, EMPTYLINE1, EMPTYLINE2 and EMPTYLINE3 recognize zero, one, two, or three
empty lines between paragraphs. These constants were used in SLIB version 2.xx, but, since text formatting
is performed in WinBraille and no longer covered by the SLIB contraction rules, these constants will hardly
ever be used in any current or future contraction rules.
 
BOLD_ON, BOLD_OFF, ITALIC_ON, ITALIC_OFF, UNDERLINE_ON and UNDERLINE_OFF are
used in contraction rules when these attributes can be marked in Braille. Attribute rules must be defined if
any of the attributes BOLD, ITALIC or UNDERLINE is defined, see the SLIB command attribute.
TAB, NEWLINE and NEWPAGE are aliases for the tabulator character, the new line marker and the new
page marker respectively. These constants are used in the tabulator, new line and new page rules. The
BRL_NEWLINE and BRL_NEWPAGE constants are the corresponding Braille symbols for the new line
and new page markers. The new line and new page rules must be defined for the translation process to work
properly. Normally the new line and the new page markers are not translated, but kept as they are, as this
example shows:
 
< ; NEWLINE ; ; BRL_NEWLINE ; NEWLINE >
< ; NEWPAGE ; ; BRL_NEWPAGE ; NEWPAGE >
 
 
The alias BRL_p7 is used to define the seventh dot Braille symbol. Since the seventh dot Braille symbol is
used as an "escape" for the Braille constants, the seventh dot Braille symbol itself must be typed twice to be
recognized as a seventh dot Braille symbol. (This is not used in the current version of WinBraille, though,
since eight-dot Braille is not implemented).

The values ORIGINAL_TEXT, EMPTY, FULL_CELL or SPACE can be used in a default statement, see
the SLIB command default.
 
The constant UPDATE is used if dependent files are defined and they should be updated when a new version
of the contraction rules is loaded from the internet, see the SLIB command depend.
The text attributes BOLD, ITALIC and UNDERLINE are used in attribute statements. The attribute
statement, if used, enables the attributes selection in WinBraille, see the SLIB command attribute.
The TRANSLATION state definitions TRANSLATION_ON and TRANSLATION_OFF can be used in
istate and interface definitions to give the user an option to select whether translation should be performed or
not, see the SLIB commands istate and interface.
 
The SOURCE state definitions SOURCE_PRINT and SOURCE_BRAILLE can be used in istate and
interface definitions to give the user an option to tell the translation engine whether the source text to be
translated is in black print, with a normal Windows font, or in Braille, typed with the proprietary Index
Braille font. See the SLIB commands istate and interface.
The Braille table definitions BRAILLETABLE, CUSTOMBRAILLE, MITBRAILLE and EUROBRAILLE
can be used in a brailletable statement to define the default Braille table or in an istate statement if more than
one Braille table is available for the contraction rules, see the SLIB commands brailletable and istate.
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The character sets ANSI_CHARSET (character set for most western European languages),
GREEK_CHARSET, etc. are used in a charset statement to define the proper character set for the translation
rules, see the SLIB command charset.

9.4.8 The Symbol Definitions
 

Some often used symbols, as for example the number prefix and capital prefix symbols, can be defined as
new identifiers with the predefined keyword define, in the same way as the definitions above. Note that these
definitions have no meaning to the WinBraille Contraction Rule Engine other than just a simple method to
make it easier to later define the contraction rules and to make the rules more readable.
Example:
 

- Prefixes for text.
- Number prefix 
define NP_text       = "#"
- Capital prefix
define CP_text       = "'"
- Multi-capital prefix
define MCP_text      = "''"

 
 

And the corresponding Braille prefixes:
 

- Prefixes for Braille.
- Number prefix
define NP_Braille    = p3456
- Capital prefix
define CP_Braille    = p6
- Multi-capital prefix
define MCP_Braille   = p6 p6

 
 

It is convenient to declare all frequently used constants, as for example state variable values for the state
declaration. Note that the hyphen ("-") is used in the left most column to mark a comment.

9.4.9 The Character Set Definition
 

Since the source file is a standard text file, there must be a way for the WinBraille Rule File Editor to
recognize the language and the character set to use, to be able to show the proper characters on the screen.
The character set is thus declared with the predefined keyword charset as:
 

charset <character set>
 

 

Example:
 

charset 0
 

 

To ease the character set definition, any of the predefined character set constants can be used as alias for the
numerical value:
 

charset ANSI_CHARSET
 

 

Note: The text string ANSI_CHARSET must have been defined with the line "define ANSI_CHARSET = 0"
before it can be referenced in a "charset" definition.

9.4.10 The Password Definition
 

The source file can be protected with a password. The Rule File Editor will not extract the source code from
a protected binary translation file unless the password is entered correctly. Password declaration example:
 

password = "drowssap"
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9.4.11 Default Character Definition

If none of the translation file's translation rules apply, the translation engine will act with a default behavior.
The default behavior is defined with the default statement. The default statement has the following syntax:
 

default = <default character>
 

 

The default character can either be a string with one character, a Braille symbol, an empty string, or the
escape character "\d027", or any of the predefined symbols ORIGINAL_TEXT, EMPTY, FULL_CELL or
SPACE. The escape character will use the source text character as the translated character. The empty string
will not translate the source text at all.
Example:
 

default = "?"

9.4.12 The Attribute Definitions

The attribute statement will enable WinBraille's attribute check boxes Bold, Italic and Underline. If
any of these boxes is enabled, a corresponding rule must be defined in the translation file. If no such rule is
defined in the translation file, the corresponding attribute check box should not be enabled. If any of the
check boxes is marked, the corresponding text attribute in the source document will be translated to Braille.
The statement syntax is:
 

attribute = <attribute constant>
 
Where attribute constant is one of the predefined constants BOLD, ITALIC or UNDERLINE. More than
one attribute statement can be defined, example:
 

attribute = BOLD
attribute = ITALIC

 
 

The corresponding rules must handle the symbols BOLD_ON, BOLD_OFF, ITALIC_ON, ITALIC_OFF,
UNDERLINE_ON and UNDERLINE_OFF, example:
 

<  ; BOLD_ON  ;  ; p45 >
<  ; BOLD_OFF ;  ; p6  >

9.4.13 States

9.4.13.1 The State Definitions

 
The contraction rule engine in WinBraille version 3.xx can handle state information. A state is for example if
capital prefix should be used or whether the text mode (or "state") is "bold letters are currently typed". Four
conceptually different types of states exist, user defined states, declared with a state declaration, local states,
declared with an lstate declaration, global states, declared with a gstate declaration, and internal, or interface
states, declared with an istate declaration.
 
States are declared with any of the state declaration state, lstate, gstate or istate, followed by a state variable
name, an equal sign, and a list of state alternatives, enclosed with brackets, and separated with commas:
 

lstate STATENAME = [ALTERNATIVE1, ALTERNATIVE2, ALTERNATIVE3]
 
The first alternatives, ALTERNATIVE1 in the example above, is always the default state, and must have
value 0 for user defined states (or 256, 512 or 768 for global states, local states and interface states
respectively).
The states can be used in interface declarations, extern declarations or parameter declarations, see
description of respective section below. The states can also be used in the rules, as the examples below
demonstrate:
Different rules can be applied depending on the value of the state, as shown in the example below. The first
rule will be applied only if the GRADE is GRADE2.
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<(GRADE=GRADE2)  ; "this" ;   ; "!"    >
<(GRADE=GRADE1)  ; "this" ;   ; "this" >

 
 

The next example shows how two states can be combined. The rule will only apply if both BRAILLE is
SWEDISH and AMBIGUITY is SPACE.
 

<(BRAILLE=SWEDISH,AMBIGUITY=SPACE); "½" ;digit; p3456 p1 p34 p3456 p12 p
;"#1/#2 ">

 
 

The two rules below demonstrate how the state can be changed dynamically. Letter prefix mode will be
"ON" if a "<" character is typed, and "Off" when a ">" is typed.
 

<  ; "<" ; ; (LETTERPREFIX=LETTERPREFIXON)>
<  ; ">" ; ; (LETTERPREFIX=LETTERPREFIXOFF)>

 
 

Two states can be set at once, as the following example demonstrates:
 

<  ; "¤" ; ; (LETTERPREFIX=LETTERPREFIXOFF, NUMBERPREFIX=NUMBERPREFIXOFF)>
 

9.4.13.2 The User Defined State
 

User defined states are used when it is important to exactly know the values of the state alternatives, as for
example when the same state variable is declared in many rule files. 
Example:
 

define GRADE0 = 0
define GRADE1 = 4
define GRADE2 = 8
define GRADE3 = 12
state GRADE = [GRADE0, GRADE1, GRADE2, GRADE3]

 
 

Note that the state alternatives are defined with the define declaration. The state itself is defined through the
state declaration. There are some rules that must be followed when the state values are defined: The first
alternative must be zero, the second must be a power of 2 (1, 2, 4, 8, 16, 32, 64 or 128), the third, fourth etc.
must be a multiple of the second, no alternative can have a higher value than 255, and all state alternatives
for all user defined states must be unique numbers.
 
The user defined state is a global state, in the sense that if the same state is declared in many rule files, they
will have the same values.

9.4.13.3 The Global State
 

The global state is used when the value of the state should be maintained from one translation to the next.
The different state alternatives are not declared with a define statement, as the user defined state alternatives.
The SLIB system will set the values automatically. It is therefore important that, if the same state is used in
many rule files, the global state variables must be declared in the same order in all rule files. Declaration
example:
 

gstate GRADE = [GRADE0, GRADE1, GRADE2]

9.4.13.4 The Local State

The local state is declared as the global state, but its value is local to a single translation. Declaration
example:
 

lstate GRADE = [GRADE0, GRADE1, GRADE2]

9.4.13.5 The Internal, or Interface State
 

The interface state can only be set in an interface declaration, nowhere else, specifically not in a rule
declaration. Both the state variable name and the state alternatives must be declared in prior to usage, since
the interface state controls internal behavior of the WinBraille contraction rule engine, and thus all interface
declarations must have values also known by the contraction engine. The constants TRANSLATION,
TRANSLATION_ON, TRANSLATION_OFF, SOURCE, SOURCE_PRINT, SOURCE_BRAILLE,
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BRAILLETABLE, CUSTOMBRAILLE, MITBRAILLE and EUROBRALLE can be used in an interface
state declaration. (These constants are defined in the predefined definitions section).
 
Declaration example:
 

istate BRAILLETABLE = [CUSTOMBRAILLE, MITBRAILLE, EUROBRAILLE]
 

 

The alternatives must be in consecutive order.
The BRAILLETABLE state values control the Braille table used for the translation to Braille. The Braille
table defined in the translation file will be used when BRAILLETABLE = CUSTOMBRAILLE, The
American Braille table will be used if the vale is MITBRAILLE, and the European Braille table will be used
if the value is EUROBRAILLE.
See the Interface Definitions on how to use the interface state definitions to control the translation behavior.

9.4.14 Interface

9.4.14.1 The Interface Definitions

 
An interface definition makes it possible to set parameters for the translation from within WinBraille.
Different translations can be performed for different styles with the same rule files defined, but with different
parameter settings. The interface is defined with an interface statement. Two types of interfaces can be
defined, interfaces based on state variables and interfaces with variables.

9.4.14.2 State Interface

A state interface statement has the following syntax:
 

interface STATEVARIABLE = "Title text" ["Alternative 1", "Alternative 2" ...]
 

 

A state declaration (state, gstate, lstate or istate) for the STATEVARIABLE state variable must precede the
state interface declaration. The state interface will appear as a list box selection in WinBraille. The "Title
text" is a descriptive title for the list box. The alternatives enclosed within brackets are the list box
alternatives. The first alternative corresponds to the first state variable value alternative, the second
alternative corresponds to the second state variable value alternative, and so on. Example:
 
gstate CAPITALPREFIX = [CAPITALPREFIXON, CAPITALPREFIXOFF]
interface CAPITALPREFIX = "Capital Prefix:" ["On", "Off"]

9.4.14.3 Variable Interface

A variable interface statement has the following syntax:
 

interface @n = "Title text"
 

 

Where @n is one of the variables @1 to @9. The variable interface will appear as an edit field in WinBraille.
The "Title text" is a descriptive title for the edit field. Example:
 

interface @9 = "Capital Prefix:"

9.4.14.4 Interface Declaration Example
 

Let us create an interface for the following user selections:
 
· Capital Prefix: On or Off
· Braille Table selection, with three options: A Bulgarian Braille table, defined with braille statements, an

American Braille table, and a European Braille table.
· An option to select whether to perform a translation or not.
· An option to select whether the source is in Braille or typed with printable characters.
· An option to select a specific character for the bullet symbol
 
We need to create a state variable for the capital prefix selection:
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gstate CAPITALPREFIX = [CAPITALPREFIXON, CAPITALPREFIXOFF]
 

 

The Braille table options, the translation options, and the source options must be declared as istate
declarations. (The constants are defined in the predefined definitions section).
 

istate BRAILLETABLE = [CUSTOMBRAILLE, MITBRAILLE, EUROBRAILLE]
istate TRANSLATION = [TRANSLATION_ON, TRANSLATION_OFF]
istate SOURCE = [SOURCE_PRINT, SOURCE_BRAILLE]

 
 

The interface proper is defined with the interface keyword:
 

interface CAPITALPREFIX = "Capital Prefix:" ["On", "Off"]
interface BRAILLETABLE = "Braille Table:" ["Bulgarian", "American",
"European"]
interface TRANSLATION = "Translation:" ["On", "Off"]
interface SOURCE = "Source:" ["Print", "Braille"]

 
 

The bullet symbol interface is declared as:
 

interface @9 = "Bullet:"
 

 

The variable @9 is then used in the rules whenever the bullet symbol is referenced. The interface will look
like:

 

9.4.15 External Rules

9.4.15.1 External Translation Rules

 Externally defined contraction rules can be applied if the rules are defined in a Windows 32-bit DLL and
the translation can be performed with a single function call. Three SLIB statements are involved in the
definition of the external rules: param, extern and depend.

9.4.15.2 The Parameter Definition
 

The param statement defines parameter values for the externally defined function's parameter. The syntax is:
 

param STATEVARIABLE = [ALTERNATIVE1, ALTERNATIVE2, ...]
 

 

A declaration of the state variable STATEVARIABLE must precede the param statement. Only one
parameter definition can be defined in each translation file.

9.4.15.3 The External Function Definition
 

The extern statement defines the external function proper. The syntax is:
 

extern = "external dll", "function name", method, parameter(s)
 

 

The first string is the name of the external DLL, example: "bm.dll". The second string is the name of the
function, as it should be called from Windows, example: "_BmTranslate@20". Method is an ordinal number
indicating how to call the function and number and types of the parameters. Currently one method exists,
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with ordinal 1. Parameter(s) is one or more parameters, depending on the method. Method 1 defines one
parameter, defined as a state variable, see the example below. The calling convention for method 1 is, as
defined as a C code function declaration:
 

HRESULT function (UINT nMode, LPCSTR lpszIn, UINT nBufferSize,
                  LPSTR lpszBuffer, UINT *pActualSize);

 
 

nMode is the parameter in the extern declaration, lpszIn is the text string to be converted, nBufferSize is the
size of the out buffer, lpszBuffer is the text out buffer for the translated text, and pActualSize contains the
actual number of converted characters in the out buffer. The return value is S_OK on success and E_FAIL
on error.

9.4.15.4 The Dependent File Definition
 

If the external function needs support from dependent files, these can be embedded in the binary .ibk
translation file with depend statements. The syntax is:
 

depend = "dependent file"
 

or
depend = UPDATE, "dependent file"

 
 

The file will normally not be extracted from the .ibk-file if it already exists when the .ibk-file is updated. Use
the second form of the depend statement if the dependent file should be extracted from the .ibk-file when the
.ibk-file is updated.
Example:
 

define GRADE0 = 0
define GRADE1 = 1
define GRADE2 = 2
state GRADE = [GRADE0, GRADE1, GRADE2]
interface GRADE = "Grade: " ["Grade 0", "Grade 1", "Grade 2"]
param GRADE = [1, 2, 3]
extern = "bm.dll" "_BmTranslate@20", 1, GRADE
depend = UPDATE, "bm.ini"
depend = "bm.lex"

9.4.16 Lists

9.4.16.1 The List Definitions
 

Many rules apply to sets of symbols, as for example the capital prefix rule, which applies to capital
characters, or rules that maintain number prefix, where the symbol set should contain the symbols that
maintain number prefix.
To be able to create a rule that applies to a symbol set, a list of symbols is defined in a list definition. (This
list can not be used in a contraction rule directly. The list must first be applied to a list rule, to define how
the list should be treated in the contraction rules, see "The List Rule Definitions". The list rule can then be
used in the contraction rule definition). 
 
Commonly used lists are:
· the list of upper case letters,
· the list of lower case letters,
· the figures,
· a list of the symbols that maintain number prefix,
· a list of the symbols that maintain capital prefix,
· the list of spaces,
· the list of punctuation marks,
· the list of symbols that can appear in an empty line,
· the list of the characters that correspond to the figures. (Usually the letters a to j, but, in for example

Greek, also the corresponding Greek letters. If no capital prefix is used, this list must also contain the
upper case letters A to J). This list is used in the rule that breaks a number in case one of the letters a to j
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follows immediately after the number.
 
The example below is taken from the American grade two translation file, with rules for number and capital
prefix:
 

list lowerletter_list = ["a","b","c","d","e","f","g","h","i","j","k",
+                        "l","m","n","o","p","q","r","s","t","u","v",
+                        "w","x","y","z","š","œ","à","á","â","ã","ä",
+                        "å","æ","ç","è","é","ê","ë","ì","í","î","ï",
+                        "ð","ñ","ò","ó","ô","õ","ö","ø","ù","ú",
+                        "û","ü","ý","Þ","ÿ","ß"]
list upperletter_list = ["A","B","C","D","E","F","G","H","I","J","K",
+                        "L","M","N","O","P","Q","R","S","T","U","V",
+                        "W","X","Y","Z","Š","Œ","À","Á","Â","Ã","Ä",
+                        "Å","Æ","Ç","È","É","Ê","Ë","Ì","Í","Î","Ï",
+                        "Ð","Ñ","Ò","Ó","Ô","Õ","Ö","Ø","Ù","Ú",
+                        "Û","Ü","Ý","þ"]
list digit_list       = ["1","2","3","4","5","6","7","8","9","0"]
list letter_list = [upperletter_list, lowerletter_list]

list lowerletter_a_to_j_list = ["a", "b", "c", "d", "e",
+                               "f", "g", "h", "i", "j"]
list maintain_NP_list = [",", ".", ":", ";", "-", "/"]
list maintain_CP_list = [maintain_NP_list]
list space_list = [" ", TAB, STARTOFPARAGRAPH]
list end_list = [ENDOFPARAGRAPH, ENDOFTEXT, NEWLINE, NEWPAGE]
list pm_list = [space_list, ",", ".", ":", ";", "!", "?", end_list]
list empty_line_list = [TAB, " ", end_list]

 
 

Note:
· A list is defined with the keyword list and the brackets "[" and "]".
· The symbols in a list are strings enclosed within quotation marks, and separated with a comma.
· A "+" sign is used in the left most column to extend a line to the next line.
· A previous list definition can appear in a list definition (as in letter_list, pm_list, and empty_line_list).
· The punctuation mark list (pm_list) contains the end_list. This is because a word at the end of a line

should be treated as if a punctuation mark follows.

9.4.16.2 The List Rule Definitions

A list can not be used in a contraction rule directly. The list must first be applied to a list rule, to define how
the list elements should be treated in the contraction rules. This is done with the keyword listrule.
The syntax is:
 

listrule <name> = <list>:<method>
 

 

<name> is the assigned list rule name. The list rule applies to the list <list> (previously defined). <method>
defines how the elements in the list should be treated in the contraction rules:
 

Method Meaning
* Zero or any number of symbols from the list.
n# Exactly n elements from the list, where n is a decimal number.
n* At least n elements from the list. Example: :1* means at least one element.
*! Zero or any number of the same symbol from the list.
n! Exactly n of the same element from the list.
n*! At least n of the same element from the list.

 

 

Example:
 

listrule lowerletter = lowerletter_list:1#
listrule upperletter = upperletter_list:1#
listrule upperletters = upperletter_list:2#
listrule letter = letter_list:1#
listrule digit = digit_list:1#
listrule lowerletter_a_to_j = lowerletter_a_to_j_list:1#
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listrule maintain_NP = maintain_NP_list:1*
listrule maintain_CP = maintain_CP_list:1*
listrule space = space_list:1#
listrule pm = pm_list:1#
listrule empty_line = empty_line_list:*

 
 

Note: A list can be used in more than one list rule definition, as in the list rules upperletter and upperletters.

9.4.16.3 The Character Equivalence Definitions

To avoid defining all text symbols in the contraction rules with both lower case and upper case characters,
the equivalence keyword can be used to define the equivalence between two lists, as for example the lower
case and the upper case lists. The equivalence does not apply to text symbols in lists, though.
The syntax is:
 

equivalence <original list> = <equivalent list>
 

 

Example:
 

equivalence lowerletter_list = upperletter_list
 

 

With this equivalence definition, only lower case letters need to be used to type letter symbols in the
contraction rules. The drawback is that if it is important to differ between lower case and upper case letter,
this can not be done with a letter symbol. (For example if a word with only capital letters should be
contracted, but not if the same word is spelled with lower case letters). Since the equivalence does not apply
to lists, this can be performed by defining a list containing the single word in question.
 
Example: Instead of using the word "ABBA" in the contraction rules, a list and a list rule can be defined:
 

list ABBA_list = ["ABBA"]
listrule ABBA = ABBA_list:1#

 
 

Now the defined identifier ABBA can be used in the contraction rule instead of the text symbol "ABBA",
and no equivalence conversion will be performed.

9.4.17 Translation Rules

9.4.17.1 The Contraction Rules: Inserting Rules and Replacing Rules

The WinBraille contraction rules are of two different kinds: Inserting rules and replacing rules. Inserting
rules are used to insert Braille symbols after, between or before characters (as for example number prefix).
Replacing rules replace text with the Braille counterpart.
The contraction rule engine will first browse through the inserting rules, and if a matching rule is found that
matches the current text in process, that insertion rule will be applied. The engine will then discontinue with
the insertion rules and continue with the replacing rules. The first replacing rule that matches the text proper
will then be applied, and the conversion process terminates. A jump to the next text to be processed is then
performed. This does not necessarily need to be a single character, but as many characters as have been
processed by the previously applied replacing rule.
 
All rules use the same syntax. Every rule is a tuple (usually a quintuple, i.e. a tuple with five elements)
delimited between "<" and ">". The elements in the tuple are delimited with semi-colon, ";". The first three
elements in the tuple are the text context. The fourth is the contracted Braille symbols and the fifth is the
corresponding contracted text. 
The fifth element, the contracted text, or the fourth element, the Braille symbol, can be excluded, but not
both, if a Braille table is supplied. If the fifth element is excluded, it will be derived from the Braille symbol
and the Braille table. If the fourth element is excluded, it will be derived from the contracted text and the
Braille table.
 
Consider the following example (from the American grade 0 rules):
 

<       ; "a"   ;       ; p1    ; "a"   >
 

 

This rule will replace all "a" in the original text with the Braille symbol p1, i.e. dot 1. The corresponding
contracted text symbol is "a" (the fifth element in the tuple). The text proper, to be converted, is the second
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element in the tuple. The first element is the context to the left of the text to be converted, and the third is the
right context. Since, in grade 0, all "a"s should be converted to the same Braille symbol, no matter what the
left and the right context is, these fields are empty. 
Consider now some more examples (from the American grade 2 rules):
 

<       ; "ar"  ;       ; p345  ; ">"   >
 

 

In this case all letter groups "ar" will be converted to the Braille symbol p345, which, in MIT-coding is a ">"
symbol. It is important to define the ">" symbol as the contracted text symbol so the proper Braille symbol
(p345) can be read on a Braille display. To illustrate why this is important, consider the following rule:
 

<       ; "1"   ;       ; p1    ; "1"   >
 

 

This will look all right on the screen. Assume now that the Braille display uses MIT coding (i.e. American
grade 0). In this coding, the figure 1 is expressed as dot 2, and not dot 1. This means that the person that
reads the Braille display will read dot 2, while the Braille window in WinBraille will display a dot 1 symbol,
but the contracted text window shows a "1". To read the proper symbol on the Braille display, we must
define the rule as:
 

<       ; "1"   ;       ; p1    ; "a"   >
 

 

I.e. with an "a" as the contracted text symbol.
Let us now go back to the grade 2 example. Say that all letters "a" should be converted to Braille symbol p1,
except for those words that contain "ar", where "ar" should be converted to the Braille symbol p345.
Suppose we write the rules:
 

<       ; "a"   ;       ; p1    ; "a"   >
<       ; "ar"  ;       ; p345  ; ">"   >

 
 

This will not work, however, since the first of the two rules is the first that will be encountered, i.e. all "a"s
will be converted to the Braille symbol p1. When we thereafter come to the next rule, i.e. rule "ar", all "a"s
have already been converted. For this to be in effect, we have to reorder the rules:
 

<       ; "ar"  ;       ; p345  ; ">"   >
<       ; "a"   ;       ; p1    ; "a"   >

 
 

Now we will first take all words with "ar" and convert "ar" to the Braille symbol p345. When this rule fails,
i.e. when an "r" does not follow the "a". we will go to the next rule, i.e. the "a" rule.
But what will happen with for example the word "arrive"? In this word, "ar" should not be converted to the
Braille symbol p345, but the "a" should be converted to Braille symbol p1 and the "r" should be converted
to Braille symbol p1235. To solve this problem, we insert an exclusive rule for the word "arrive" before the
"ar" rule:
 

<       ; "a"   ;"rrive"; p1    ; "a"   >
<       ; "ar"  ;       ; p345  ; ">"   >
<       ; "a"   ;       ; p1    ; "a"   >

 
 

It is thus important to organize the rules in the proper order.

9.4.17.2 The Inserting Rules
 

Inserting rules are used to insert Braille symbols after, between or before characters. The second tuple
element is thus empty. Example:
 

<digit ; ; lowerletter_a_to_j ; p56 ; ";" >
 

 

This rule resolves the ambiguity if one of the letters a to j follows a number. In this case a semi-colon (";",
dots 5 and 6) will be inserted before the letter. The list rules digit and lowerletter_a_to_j must have
been defined earlier.

Common inserting rules are the capital prefix rules and the number prefix rules. (The rules in the examples
are not taken from any translation file. They are just given as examples. They can be copied and changed to
suit specific needs).
 

Number Prefix Rules
 

 

<digit      ;       ; "."       ;                ;             >
<           ;       ; "." digit ; NP_Braille     ; NP_text     >
<"."        ;       ; digit     ;                ;             >
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<digit      ;       ; digit     ;                ;             >
<digit maintain_NP; ; digit     ;                ;             >
<           ;       ; digit     ; NP_Braille     ; NP_text     >

 
 

If we analyze these rules, we see that:
 
· Rule 1: if a decimal point follows a digit, no number prefix will be inserted. This rule is needed because of

rule 2.
· Rule 2: If a decimal point is followed by a digit, a number prefix is inserted before the decimal point.
· Rule 3: If a digit follows a decimal point, no number prefix will be inserted. This rule is needed as a result

of rule 2, since the prefix has already been inserted.
· Rule 4: If a digit follows another digit, no number prefix is inserted. There is no need to insert a prefix

after every digit.
· Rule 5: If one or more symbols that should maintain number prefix follow a digit, no prefix is inserted

after theses symbols, even if a digit follows.
· Rule 6: If a digit follows anything else, a number prefix is inserted.
 
Note that the order of the rules is important.
 

Capital Prefix Rules
 

 

<upperletter; ; upperletters lowerletter ;            ;             >
<           ; ; upperletters lowerletter ; CP_Braille ; CP_text     >
<           ; ; upperletter lowerletter ; CP_Braille  ; CP_text     >
< ; ; upperletters maintain_CP lowerletter ; CP_Braille ; CP_text   >
< ; ; upperletter maintain_CP lowerletter ; CP_Braille ; CP_text    >
<upperletter; ; upperletter    ;                      ;             >
<upperletter, maintain_CP; ; upperletter ;            ;             >
<           ; ; upperletters   ; MCP_Braille          ; MCP_text    >
<           ; ; upperletter    ; CP_Braille           ; CP_text     >

 
 

Analyzing these rules:
·  Rule 1: If two capitals followed by a lower letter, follow a capital, no prefix is inserted. This is needed to prevent rule 2 to

be activated in case more than two capitals are proceeded by a lower letter.
· Rule 2: If two capitals proceed a lower letter, a single capital prefix is inserted before the two capitals, except when

there are more than two capitals. The latter case will be handled by rule 1, and will thus never reach rule 2.
· Rule 3: If one capital proceed a lower letter, a single capital prefix is inserted before the capital. (This is the reason

why a single capital prefix is inserted in rule 2 and not a multi-capital prefix).
·
· Rule 4: This rule is the same as rule 2, but there are symbols that maintain capital prefix before the lower letter.
·  Rule 5: This rule is the same as rule 3, but there are symbols that maintain capital prefix before the lower letter.
·  Rule 6: If a capital follows a capital, no prefix is inserted. (The cases when lower case letters follow a capital are

taken care of in rules 1 to 3).
·  Rule 7: If one or more symbols that should maintain capital prefix are inserted between capitals, no prefix should be

inserted before the second capital.
·  Rule 8: If two capitals follow, a multi-capital prefix is inserted.
·  Rule 9: If one capital follows, a single-capital prefix is inserted.
 

The inserting rules end with an empty rule:
 

<    ;    ;    ;    ;    >
 

9.4.17.3 The Replacing Rules

Immediately following the inserting rules comes the replacing rules section. These rules do have a text
symbol as the second element in the rule tuple.
Almost mandatory rules are the rules for end of page and end of line, the space rules and the tabulator rules:
 

End of page and end of line rules
 

 

<            ; NEWLINE   ;  ; BRL_NEWLINE   ; NEWLINE   >
<            ; NEWPAGE   ;  ; BRL_NEWPAGE   ; NEWPAGE   >

 
 

The first of these rules is the empty line rule. The last rule takes care of new page markers. If this rule is not
included, no new page markers will be re-inserted in the translated text.
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Space and Tabulator Rules
 

 

The task for the space rules is to maintain the space in the translated text
 

<" "        ; " "    ;                ; p             ; " "         >
<TAB        ; " "    ;                ; p             ; " "         >

 

After the space and tabulator rules, all other replacing rules will follow. It is thus important to organize the
rules properly. All rules where the text in the second tuple element start with the same character should be
grouped together, i.e. all rules should be in "alphabetical" order.
Example (from the American grade two rules): The pound sign ("£") should be an "l" (dots 1, 2 and 3)
before a number, otherwise the "l" should be proceeded with a dot-4 Braille symbol (the "@"-sign if MIT
coding is used). All "£" rules must thus be grouped together.
 

<           ; "£"    ;digit           ; p123          ;"l"          >
<           ; "£"    ;"." digit       ; p123          ;"l"          >
<           ; "£"    ;                ; p4 p123       ;"@l"         >

 
 

There are two rules worth to be mentioned: The rule for the backslash ("\") and the rule for the quotation
mark ("""): Since the backslash symbol is used as an "escape", we type backslash twice to define the
backslash symbol:
 

<           ; "\\"   ;                ; p45 p34       ;"^/"         >
 

 

The quotation mark is used to define text strings. The string """ would be too confusing for the WinBraille
Contraction Rule Engine. Instead we use the "escape" symbol together with the """ symbol to define a singe
""" symbol: "\"".
 

<           ; "\""   ;                ; p236          ;"8"          >
 

 

Rules that include list rules in the second tuple element
 

 

List rules are allowed in the second tuple element, the text proper, in SLIB version 3.xx rules. This will
reflect the sorting order of the rules slightly. The rules shall still, as in the SLIB version 2.xx rules, be sorted
"alphabetically", in the sense that all rules with the same first letter in the second element need to be grouped
together to prevent the translation engine to search all rules at every translation occasion. A second rule tuple
element that starts with a list rule can not follow this scheme, though. To prevent the translation engine to
mish-mash the translation, these kinds of rules must be inserted either before all other replacing rules, or last
in the list of replacing rules. If they are placed before all other rules, they will be validated before the rules
that start with string symbols. If they are placed last among the rules, they will only be reached if no other
"normal" rule has been matched.

9.4.17.4 Rule Order

A proposed rule order would be:
· Inserting Rules.
· Number prefix rules, letter prefix rules, rules to resolve ambiguities etc.
· Replacing Rules with a list rule first in the second element.
· Typically rules for double words and other rules that can not be specified otherwise.
· Replacing Rules with an escape character as the first character in the second element.
· The BOLD_ON, BOLD_OFF, ITALIC_ON, ITALIC_OFF, UNDERLINE_ON and UNDERLINE_OFF

rules belong to this category.
· Replacing Rules with a non-printable character as the first character in the second element
· NEWLINE, NEWPAGE and TAB rules.
· Replacing Rules with a printable character as the first character in the second element.
· Space, symbol, character, and word rules belong to this category. All rules with the same first letter in the

second rule tuple should be grouped together.
· Replacing Rules with a list rule first in the second element.
· Rules that will be validated if no other rules have been applied.
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9.4.17.5 Control Translation Order for a Single Rule

The default order when a rule is tested is to first test the text proper, i.e. the second element, then test the
right context, i.e. the third element, and lastly test the left context, i.e. the first element. The rule will pass if
all tests pass. There might be circumstances when this order is not feasible. Inserting an order modifier
immediately after the start-of-rule marker, "<", will reorder the tests. Available order modifiers are:
%LR Modifier for inserting rules. Test the left context first, then the right context
%RL Modifier for inserting rules. Test the right context first, then the left context
%LTR Modifier for replacing rules. First test the left, then the text, and last the right context.
%TLR Modifier for replacing rules. First test the text, then the left, and last the right context.
%TRL Modifier for replacing rules. First test the text, then the right, and last the left context.
No other orders are possible, The text must be tested before the right context, since the translation engine
must determine where the text ends before the right context can be tested.
 
Example:
 

<%TRL letter ; "and" ; "ers" ; p12346 ; "&" >
 

 

It is better to test the right context before the left in this example, since it is faster to check whether a string
with three letters will pass or fail than testing for all elements in the list rule letter.

9.4.17.6 Using and Assigning Variables

The nine variables @1 to @9 can be assigned and used in the rules. Assignment is performed with curly
brackets, "{" and "}". Entities assigned to a variable are enclosed within the brackets. More then one
variable can be assigned in the rule. The left most group of bracket enclosed entities is assigned to variable
@1, the second group is assigned to variable @2, and so on, see the examples below. A variable used in the
first, second or third tuple element will be checked against the left context, the text proper or the right
context respectively. A variable used in the fourth tuple element will be used as the translated text for the
rule. The translated Braille symbols will be determined from the variable and the Braille table. The fifth
element can not be defined if a variable is used in the fourth tuple element.
 
The example below shows how to assign a text string to a variable. The characters that will pass list rule
letters will be assigned to variable @1. The variable will thereafter be checked against the left context. If the
left context contains the same characters as the letter string after the hyphen in the text to be converted, the
whole rule will pass. The hyphen and the letters will then be converted to an equal sign. Here it is important
to check the second tuple element before the first to ensure that the variable has been assigned a proper text
string before it is checked against the left context. The %TLR modifier is used for this purpose.
 

<%TLR @1 ; "-" {letters} ; pm ; "=" >
 

 

The next example shows how to assign two variables. The text "abc" will be assigned to variable @1, since
this is the left most curly bracket enclosed group of entities. The text "xyz" will be assigned to variable @2,
since this is the second curly bracket enclosed group of entities. The letters "abc" will be converted to "xyz"
if this rule pass (i.e. if the text "abcxyz" exists).
 

< ; {"abc"} ; {"xyz"} ; @2 >
 

9.4.17.7 Recursive Translation

Variable content can be recursively translated with the symbol &n, where n is the variable index. Example:
Suppose a variable interface has been declared for the variable @9 in the American grade 1 rules and the
variable has been assigned the symbol "!" through the WinBraille interface. The first rule below will produce
a "!" before each digit on the screen, and dots 2, 3, 4 and 6 in Braille. The second will produce a "6" before
each digit on the screen, and dots 2, 3 and 5 in Braille, since a "!" will be converted to "6", with dots 2, 3
and 5 as a Braille symbol, if the American grade1 rules are applied.
 

< ; ; digit ; @9 >
< ; ; digit ; &9 >
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9.4.17.8 What happens during the conversion process?

Let us see how the conversion process is performed. Imagine we have replacing rules for numbers and the
decimal point and the previously mentioned inserting rules for number prefix. Suppose we want to convert
the text "3.14". First the inserting rules are applied between the beginning and the first figure "3". Here we
will have a match with the last number prefix rule, i.e. the rule that inserts a number prefix (Braille symbol
p3456, i.e. dots 3, 4, 5 and 6). The number prefix symbol will therefore be inserted into the translated text.
We will now discontinue width the inserting rules and go to the replacing rules. The replacing rule for the
figure "3" will be found, and thus the Braille symbol p14 will be inserted into the translated text. This
terminates the conversion process. We now proceed with the inserting rules and try to apply them to the
character pair "3" and ".". The first number prefix rule will match, so we just proceed with the replacing
rules, where a match will be found for the decimal point. This will result in a Braille symbol p256 in the
translated text. Next we take the inserting rules and try to apply them to the character pair "." and "1". A
match will be found at the third number prefix rule, where after we discontinue the inserting rules and
proceed with the replacing rules, where a match is found for the figure "1", which will result in a Braille
symbol p1 in the translated text. Next we apply the inserting rules to the character pair "1" and "4". The
fourth inserting rule will make a match, so we just proceed with the replacing rules and try to apply them to
the figure "4". A match will be found, so the Braille symbol p145 will be inserted into the translated text.
This will end the conversion of the number "3.14", and the resulting translated text will have these Braille
symbols: p3456 p14 p256 p1 p145.

9.4.18 Tables

9.4.18.1 The Braille Table

Since there is not necessarily a one-to-one relation between unconverted text, translated text and Braille,
there is a possibility to define a text to Braille and Braille to text table. This table is optional. If no Braille
conversion table is defined, the table is automatically built from the rules, but if one Braille table entry is
included, all entries must be included, i.e. the whole table. If more than one text symbol is converted to the
same Braille symbol, this table tells the WinBraille Contraction Rule Engine which translated text symbol
should be chosen for a specified Braille symbol. The syntax for a Braille table element is:
 

braille <braille symbol> = <text character>
 

 

The most common Braille coding is the American grade 0, i.e. the MIT coding:
 

braille p = " "
braille p1 = "a"
braille p2 = "1"
braille p3 = "'"
braille p4 = "@"
braille p5 = "\""
braille p6 = ","
braille p12 = "b"
braille p13 = "k"
braille p14 = "c"
braille p15 = "e"
braille p16 = "*"
braille p23 = "2"
braille p24 = "i"
braille p25 = "3"
braille p26 = "5"
braille p34 = "/"
braille p35 = "9"
braille p36 = "-"
braille p45 = "^"
braille p46 = "."
braille p56 = ";"
braille p123 = "l"
braille p124 = "f"
braille p125 = "h"
braille p126 = "<"
braille p134 = "m"



157Translation File Reference

Index Braille AB

braille p135 = "o"
braille p136 = "u"
braille p145 = "d"
braille p146 = "%"
braille p156 = ":"
braille p234 = "s"
braille p235 = "6"
braille p236 = "8"
braille p245 = "j"
braille p246 = "["
braille p256 = "4"
braille p345 = ">"
braille p346 = "+"
braille p356 = "0"
braille p456 = "_"
braille p1234 = "p"
braille p1235 = "r"
braille p1236 = "v"
braille p1245 = "g"
braille p1246 = "$"
braille p1256 = "\\"
braille p1345 = "n"
braille p1346 = "x"
braille p1356 = "z"
braille p1456 = "?"
braille p2345 = "t"
braille p2346 = "!"
braille p2356 = "7"
braille p2456 = "w"
braille p3456 = "#"
braille p12345 = "q"
braille p12346 = "&"
braille p12356 = "("
braille p12456 = "]"
braille p13456 = "y"
braille p23456 = ")"
braille p123456 = "="

 
 

Note: When the Braille conversion table is defined, The fifth tuple element is obsolete, since it can be
derived from the Braille conversion table and the fourth tuple element (the Braille symbol). It is also
possible to define the fifth tuple element and skip the fourth. (I.e. typing the translated print symbol, "the
fifth element", in the fourth tuple position). The Braille symbol will in this case be constructed from the fifth
element and the Braille table.
The Braille table is used (together with the duplicate character table and the fifth tuple element) to emboss
from the translated text. When embossing from the Braille window, only the Braille symbols in the fourth
tuple element are used. It is therefore of paramount importance that the symbols in the fourth tuple element
and the elements in the Braille table coincide. If the American Braille code (MITBRAILLE) or the European
code (EUROBRAILLE) are used, we can use a brailletable statement instead of defining all Braille symbols
with 64 braille statements, example:
 

brailletable = MITBRAILLE
 

 

or
 

brailletable = EUROBRAILLE

9.4.18.2 The Duplicate Character Table

The duplicate character table is obsolete in SLIB version 3.xx, since it is internally derived from the Braille
conversion table and the fifth rule tuple element, but it can be supplied for compatibility with earlier versions
of the SLIB rules.
If more than one text symbol is converted to the same Braille symbol, the Braille table tells the WinBraille
Contraction Rule Engine which translated text symbol should be chosen for a specified Braille symbol. The
other duplicated character or characters can be defined in the duplicate character table. The syntax for a
duplicate character table element is:
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ascii <text character> = <braille symbol>
 

 
One example is when a national coding is used for the translated text symbols, and this coding does not
contain the figures 0 to 9. We can then use the figures 0 to 9 as the translated text (the fifth tuple element)
for the figures 0 to 9 in the unconverted text (i.e. the second tuple element). The duplicate character table
would in this case contain the following symbols:
 

ascii "0" = p245
ascii "1" = p1
ascii "2" = p12
ascii "3" = p14
ascii "4" = p145
ascii "5" = p15
ascii "6" = p124
ascii "7" = p1245
ascii "8" = p125
ascii "9" = p24

 

 
The figure rules would then be:
 

<           ; "0"    ;    ; p245                ;"0"        >
<           ; "1"    ;    ; p1                  ;"1"        >
<           ; "2"    ;    ; p12                 ;"2"        >
<           ; "3"    ;    ; p14                 ;"3"        >
<           ; "4"    ;    ; p145                ;"4"        >
<           ; "5"    ;    ; p15                 ;"5"        >
<           ; "6"    ;    ; p124                ;"6"        >
<           ; "7"    ;    ; p1245               ;"7"        >
<           ; "8"    ;    ; p125                ;"8"        >
<           ; "9"    ;    ; p24                 ;"9"        >
 

 

This cannot be performed if the MIT coding is used, since the figures 0 to 9 are already occupied in the
Braille table. In this case, we have to define the figure rules as:
 

<           ; "0"    ;    ; p245                ;"j"        >
<           ; "1"    ;    ; p1                  ;"a"        >
<           ; "2"    ;    ; p12                 ;"b"        >
<           ; "3"    ;    ; p14                 ;"c"        >
<           ; "4"    ;    ; p145                ;"d"        >
<           ; "5"    ;    ; p15                 ;"e"        >
<           ; "6"    ;    ; p124                ;"f"        >
<           ; "7"    ;    ; p1245               ;"g"        >
<           ; "8"    ;    ; p125                ;"h"        >
<           ; "9"    ;    ; p24                 ;"i"        >
 

 

Here we can not use the figures 0 to 9 as the translated text symbols, since the MIT coding does not code the
figures in the same way as the letters a to j. (0 is coded as p2, 2 is coded as p23, 3 is coded as p25 and so
on).
Another usage of this table can for example be for debugging purposes. We can for example omit the
equivalence definition and include rules for the capital characters as well. We then let the fifth tuple element
be the capital letters, and include these capital letters in the duplicate characters table.
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10 Appendix

10.1 Default Profile Settings

The "Index Default Installation Package" contains the following default settings:

10.1.1 Index Default Installation 1

Category Setting Default Value
Preferences Options Maximize all Windows

Automation Edit source document
Units mm (millimeters)
Keyboard Mode Standard (not 6 key entry)
Zoom 50%
Default mode when viewing a
translated file

Show Print

Embosser Old Index Embosser Not selected
See on scree embosser model info 

Duplexing Basic-S = Single sided
Everest, Basic-D = Double sided
4X4 PRO = Saddle stitch binding

Folding Option
(Only Basic-D and 4Waves PRO)

Z-folding = off

Header Odd pages Right = %b
Even Pages Right = %b
Begin Page Numbering on Braille
page:

1

Start Numbering With 1
Format Header and Footer to Style Header
Most frequent values %b = Braille Page Number

%s = Source Page Number
Tables Wrap Columns Indent each column 1 (default)

Delimiter, Row By Row Character 2
Delimiter, Column By Column Character 2
Format Tables According to Style Table

10.1.2 Index Default Installation 2

Category Setting Default Value
Lists Exchange Bullets characters with #

Indent Bullet character 0
Space between bullet character
and paragraph

1

Source Page Number Indicate page transitions in the
Braille document

Default = not tagged

Reformatting Page Breaks Remove all empty pages and page
brakes

Spaces Exchange multiple spaces with single
spaces
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Empty Lines Format empty lines according to table
Concatenate adjacent lines Never

Graphics Include Graphics in translated
document

Default = off, graphics will be deleted
during the translation to Braille.

Preferred Translated Image size Page Width
Paragraph Space Exchange multiple space with single

space
Indents Left = 0 Character

Right = 0 Character
First Line = 0 Character

Tab (not active)
Distance Top = 0 Lines

Bottom = 0 lines
Attribute (not active)
Insert page break before
paragraph

not tagged

Line Spacing 1 Lines
Alignment left
Concatenate adjacent paragraphs not tagged

Translate Translation american_g2.ibk
Translation of the text to Braille
following American Grade 2 rules

Exception general_exceptions.ibk
Separator Top Not tagged

Bottom Not tagged
Hyphenation Hyphenation No Hyphenation (Word wrap active)

10.2 Custom Installation Packages

The following Custom Installation packages exist at the time of the release of this manual.
Index default settings.

Name Description
Index default settings English Index default
Bo Jo Tveter 030321 Norwegian settings
German, Papenmeier German settings
Polar Print, svenska profiler Swedish settings
North american settings American settings
Voice System (Versione Italiana) Italian settings

Please verify on www.indexBraille.com if more custom installation packages have been released.

http://www.myhomepage.com/index.html
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